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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems StepOne™ and
Documentation  StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

Guide Purpose and Audience PN
Applied Biosystems StepOne™ and Explains how to perform experiments on the StepOne and 4376786
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems. Each Getting Started Guide functions as
Getting Started Guide for Genotyping both:
Experiments e A tutorial, using example experiment data provided with the
Applied Biosystems StepOne™ and Applied Biosystems StepOne™ Real-Time PCR Software 4376787
StepOnePlus™ Real-Time PCR Systems (StepOne ™ software).
Getting Started Guide for e A guide for your own experiments.
Presence/Absence Experiments Intended for laboratory staff and principal investigators who
Applied Biosystems StepOne™ and gesrigrmm experiments using the StepOne or StepOnePlus 4376785
StepOnePlus™ Real-Time PCR Systems Y '
Getting Started Guide for Relative
Standard Curve and Comparative Cy
Experiments
Applied Biosystems StepOne™ and 4376784
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Standard Curve
Experiments
Applied Biosystems 7500/7500Fast, 4411937
StepOne™, and StepOnePlus™ Real-Time
PCR Systems Quick Reference Card for
Comparative C; Experiments and Studies
Applied Biosystems StepOne™ and Explains how to install and maintain the StepOne and 4376782
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems.
Igz}‘zgat/on, Networking, and Maintenance Intended for laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system
Applied Biosystems StepOne™ and 4376783
StepOnePlus™ Real-Time PCR Systems
Installation Quick Reference Card
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for \
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How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems StepOne™ and Provides information about the reagents you can use on the 4379704
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems, including:

Reagent Guide ¢ An introduction to TagMan® and SYBR® Green reagents

e Descriptions and design guidelines for the following
experiment types:

— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments

Intended for laboratory staff and principal investigators who
perform experiments using the StepOne or StepOnePlus
system.

Applied Biosystems StepOne™ and Explains how to prepare your site to receive and install the 4376768
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems.

Site Preparation Guide Intended for personnel who schedule, manage, and perform the

tasks required to prepare your site for installation of the StepOne
or StepOnePlus system.

Applied Biosystems StepOne™ Real-Time | Explains how to use the StepOne software to: NA

PCR Software Help e Set up, run, and analyze experiments using the StepOne and

StepOnePlus systems.
* Monitor networked StepOne and StepOnePlus instruments.
e (Calibrate StepOne and StepOnePlus instruments.

e \Verify the performance of StepOne and StepOnePlus
instruments with an RNase P run.

Intended for:

e Laboratory staff and principal investigators who perform
experiments using the StepOne or StepOnePlus system.

e Laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system.

Assumptions This guide assumes that you:
+ Are familiar with the Microsoft Windows® XP operating system.
* Are familiar with the Internet and Internet browsers.
» Know how to handle DNA and/or RNA samples and prepare them for PCR.
* Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the StepOne or StepOnePlus
system into your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

vi Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments
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Words

Safety Alert
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Preface
How to Obtain More Information

Two user attention words appear in Applied Biosystems user documentation. Each word
implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

Safety alert words also appear in user documentation. For more information, see “Safety
Alert Words” on page xii.

How to Obtain More Information

Related
Documentation

Other StepOne and StepOnePlus System Documents

The documents listed in the table below are not shipped with the StepOne or
StepOnePlus instrument.

Document PN

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376791
Installation Performance Verification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376790
Installation Qualification-Operation Qualification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376788
Planned Maintenance Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for vii
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How to Obtain More Information

Documents Related to Genotyping Experiments

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636
Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925
viii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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How to Obtain More Information

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents Related to Standard Curve Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for iX
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How to Obtain More Information

Obtaining
Information from
the Software Help

X Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Documents Related to the Reagent Guide

Document PN
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08

for Experimental Studies Application Note

Note: For more documentation, see “How to Obtain Support” on page xi.

* Press F1.
* Click @ in the toolbar.
+ Select Help » StepOne Software Help.

To find topics of interest in the Help:

* Review the table of contents.
+ Search for a specific topic.
» Search an alphabetized index.

The StepOne Software Help describes how to use each feature of the user interface.
Access the Help from within the software by doing one of the following:

Genotyping Experiments
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Preface
How to Obtain Support

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xi).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

» Search through frequently asked questions (FAQs)

* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
» Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your StepOne™ or StepOnePlus’" instrument (such as annual planned
maintenance or temperature verification/calibration), contact the Applied Biosystems
Care Center. To obtain a phone number for or to send an e-mail to the center, go to
http://www.appliedbiosystems.com/support/contact.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xi
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Preface

Safety Conventions Used in This Document

Safety Conventions Used in This Document

Xii

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level
of observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

A (o:.\UI{e]N] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A P\[e]F38 — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xiv).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Symbols on Instruments

Examples

IMPORTANT! You must create a separate sample entry spreadsheet for each 96-well
plate.

_ (.\1)i[e]]] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

the heated cover and sample block can reach temperatures in excess of 100 °C.

A L[] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation. Never operate the system with the grounding conductor disconnected.

Symbols on Instruments

Electrical The following table describes the electrical symbols that may be displayed on
Symbols Applied Biosystems instruments.

Symbol Description Symbol Description
Indicates the On position of the I Indicates a terminal that may be
main power switch. e connected to the signal ground

reference of another instrument.

) - This is not a protected ground
Indicates the Off position of the terminal.

main power switch. |
Indicates a protective grounding
@ terminal that must be connected

Indicates a standby switch by to earth ground before any other

CO-—

which the instrument is switched electrical connections are made

on to the Standby condition. to the instrument.

Hazardous voltage may be |

present if this switch is on Indicates a terminal that can

standby. o receive or supply alternating
current or voltage.

Indicates the On/Off position of a Indicates a terminal that can

® push-push main power switch. = receive or supply alternating or
direct current or voltage.
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xin
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Symbols on Instruments

Safety Symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety Labels on Instruments” on page xv). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that
occur in the text of this and other product-support documents.

Symbol

Description Symbol Description

/N
AN

Indicates the presence of moving
parts and to proceed with
appropriate caution.

Indicates that you should consult
the manual for further information
and to proceed with appropriate

caution.
Indicates the presence of an

) electrical shock hazard and to
Indicates the presence of a hot proceed with appropriate caution.
surface or other high-temperature
hazard and to proceed with

appropriate caution.

Indicates the presence of a laser
inside the instrument and to
proceed with appropriate caution.

> B B

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
Symbols products placed on the European market after August 13, 2005.

Symbol

=,
X
9
]

Description

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste electrical and electronic equipment (WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment pick-up
and recycling. See http://www.appliedbiosystems.com for a list of customer
service offices in the European Union.

Xiv Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Safety Labels on Instruments

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

Locations of

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

ATTENTION Produits chimiques dangeureux.
Lire les fiches techniques de sireté de
matériels avant la manipulation des produits.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

CAUTION Hot surface.

ATTENTION Surface brilante.

DANGER High voltage.

DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

CAUTION Moving parts.

DANGER Class 3B (lll) visible and/or invisible
LED radiation present when open and

interlocks defeated. Avoid exposure to beam.

Warnings below:

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Genotyping Experiments

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

ATTENTION Parties mobiles.

DANGER Rayonnement visible ou invisible
d’un faisceau LED de Classe 3B (Ill) en cas
d’ouverture et de neutralisation des
dispositifs de sécurité. Evitez toute
exposition au faisceau.

The StepOne and StepOnePlus instruments contain a warning at the location shown

/A CAUTION HOT

XV
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General Instrument Safety

General Instrument Safety

A WG UII[e] PHYSICAL INJURY HAZARD. Using the instrument in a manner

not specified by Applied Biosystems may result in personal injury or damage to the
instrument.

Moving and A (.\I[e){] PHYSICAL INJURY HAZARD. The instrument is to be moved

Lifting the and positioned only by the personnel or vendor specified in the applicable site
Instrument preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Moving and AWARNING Do not attempt to lift or move the computer or the monitor without

Lifting Computers the assistance of others. Depending on the weight of the computer and/or the monitor,
and Monitors moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.
+ Keep your spine in a good neutral position while lifting with your legs.

+ Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the  Ensure that anyone who operates the instrument has:

Instrument * Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xvii.

Cleaning or A [o7\UI[e)\] Before using a cleaning or decontamination method other than those

Decontaminating recommended by the manufacturer, verify with the manufacturer that the proposed
the Instrument method will not damage the equipment.

XVi Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Safety To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xvii.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

+ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to

replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Type in the chemical name, part number, or other information that you expect
to appear in the MSDS of interest.

b. Select the language of your choice.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xvii
Genotyping Experiments
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Chemical Waste Safety

c. Click Search.

3. To view, download, or print the document of interest:
a. Right-click the document title.

b. Select:
* Open — To view the document

+ Save Target As — To download a PDF version of the document to a
destination that you choose

* Print Target — To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
. Select Fax or Email below the document title.

a
b. Click RETRIEVE DOCUMENTS at the end of the document list.

2]

. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical Waste Safety

Chemical Waste A (X[l HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

xviii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments
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Electrical Safety

* Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.
+ After emptying a waste container, seal it with the cap provided.

» Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

Electrical Safety

A pJ:\\[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the StepOne or StepOnePlus instrument without its instrument
panels in place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

Fuses AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can

damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with fuses of the type and rating specified for the instrument.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xix
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LED Safety

Power A p\e]3i] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

Overvoltage
Rating

LED Safety

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A PLWNel3i] ELECTRICAL HAZARD. Use properly configured and approved

line cords for the voltage supply in your facility.

A pE\[e]1338 ELECTRICAL HAZARD. Plug the instrument into a properly

grounded receptacle with adequate current capacity.

The StepOne and StepOnePlus instruments have an installation (overvoltage) category of
11, and they are classified as portable equipment.

To ensure safe LED operation:

* The system must be maintained by an Applied Biosystems Technical
Representative.

 All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If
any panel is removed when the LED is operating (during service with safety
interlocks disabled), you may be exposed to LED emissions in excess of the
Class 3B rating.

* Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

XX

General
Biohazard

&WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
performed in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
http://bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; http://www.access.gpo.gov/ nara/cfr/waisidx_01/
29¢fr1910a_01.html).
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Workstation Safety

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

More information about biohazard guidelines is available at:

http://www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and The StepOne and StepOnePlus instruments have been tested to and comply with
Canadian Safety standard:

Standards .,/ 1010A-1/CAN/CSA C22.2 No. 1010.1-92, “Safety Requirements for Electrical
c UI. Equipment for Measurement, Control, and Laboratory Use, Part 1: General
sLjUs Requirements.”

UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory
Equipment for the Heating of Materials.”

Canadian EMC This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Standard Scientific, and Medical Radio Frequency Generators.”

European Safety Safety

Sand EMC This instrument meets European requirements for safety (Low Voltage Directive
tandards 2006/95/EC). This instrument has been tested to and complies with standards EN 61010-
C € 1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of
Materials.”

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xxi
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Safety and Electromagnetic Compatibility (EMC) Standards

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

Australian EMC  This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
Standards and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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n Get Started

This chapter covers:

B About the StepOne™ and StepOnePlus™ Systems. . ....................... 2
B Supported Consumables . .. ...t 4
B About Genotyping Experiments. . ... ...ttt 6
B HowtoUse This Guide. .. ... ..ot 9
B About the Example Experiment . . ............. ... ...t 10
B Example Experiment Workflow .. ........ ... ... .. .. ... .. .. .. . ... 13

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 1
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About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

System Features
Applied Biosystems StepOne™ Real-Time ¢ 48-well platform
PCR System (StepOne ™ system) e Three-color system
Applied Biosystems StepOnePlus™ ¢ 96-well platform
Real-Time PCR System (StepOnePlus™ « Four-color system

system) e VeriFlex™ sample blocks

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction
(PCR) reagents to provide:

» Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The StepOne and StepOnePlus systems collect raw fluorescence data at different points
Collection during a PCR, depending on the type of run that the instruments perform:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data following each

extension step of the PCR.
Relative standard

curve

Comparative Cy

(AAGy)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional, but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time); collecting
data during the run can be helpful for
troubleshooting.

e After the PCR

Regardless of the run type, a data collection point or 7ead on the StepOne™ or
StepOnePlus™ instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

Notes
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2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The StepOne'™ software stores the
raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to
determine the location and intensity of the fluorescent signals in each read, the dye
associated with each fluorescent signal, and the significance of the signal.

About the Filters The StepOne and StepOnePlus systems use the following filters:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 | FAM™dye 1 | FAM™dye
SYBR® Green dye SYBR® Green dye
2 | JOE™dye 2 | JOE™dye
VIC® dye VIC® dye
3 | ROX™dye 3 | TAMRA™ dye
NED™ dye

4 | ROX™dye

About the The StepOnePlus instrument contains six independently thermally regulated VeriFlex™
VeriFlex™  blocks to help you optimize your thermal cycling conditions. You can set a different
Technology temperature for one or more of the VeriFlex blocks, creating up to six different zones for
samples, or you can set the same temperature for each of the VeriFlex blocks.

For More For information on:

Information + The StepOne and StepOnePlus systems, refer to Applied Biosystems StepOne"
Real-Time PCR Software Help.

Note: To access the Help, select Help » StepOne Software Help from within the
StepOne software.

* Presence/absence experiments, refer to Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence
Experiments.

» Relative standard curve and/or comparative C (AACy) experiments, refer to
Applied Biosystems StepOne"" and StepOnePlus™™ Real-Time PCR Systems Getting
Started Guide for Relative Standard Curve and Comparative C Experiments.

+ Standard curve experiments, refer to Applied Biosystems StepOne"" and
StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Curve
Experiments.

Notes
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Supported Consumables

StepOne System  The StepOne system supports the consumables listed below. These consumables are for
use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number
¢ MicroAmp® Fast Optical 48-Well Reaction Plate e 4375816
¢ MicroAmp® 48-Well Optical Adhesive Film e 4375323 and
4375928
¢ MicroAmp® Fast 8-Tube Strip e 4358293
¢ MicroAmp® Optical 8-Cap Strip e 4323032
* MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp® Fast 48-Well Tray e 4375282
* MicroAmp® 48-Well Base Adaptor e 4375284
e MicroAmp® 96-Well Support Base e 4379590

Consumable

MicroAmp® Fast Optical 48-Well Reaction Plate
MicroAmp® Fast 48-Well Tray
MicroAmp® 96-Well Support Base

MicroAmp® Optical 8-Cap Strip
MicroAmp® Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap
MicroAmp® 48-Well Optical Adhesive Film
MicroAmp® 48-Well Base Adaptor

I O m m o O © >» %

Notes
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StepOnePlus The StepOnePlus system supports the consumables listed below. These consumables are
System for use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number

¢ MicroAmp® Fast Optical 96-Well Reaction Plate with e 4346906 and
Barcode 4366932

* MicroAmp® Optical Adhesive Film e 4360954 and
4311971
e MicroAmp® Fast 8-Tube Strip e 4358293
* MicroAmp® Optical 8-Cap Strip e 4323032
¢ MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp® 96-Well Tray for VeriFlex™ Blocks e 4379983
¢ MicroAmp® 96-Well Support Base e 4379590
* MicroAmp® Adhesive Film Applicator e 4333183
¢ MicroAmp® Cap Installing Tool (Handle) e 4330015

Consumable
MicroAmp® Fast Optical 96-Well Reaction Plate
MicroAmp® 96-Well Tray for VeriFlex™ Blocks

MicroAmp® 96-Well Support Base

MicroAmp® Optical 8-Cap Strip
MicroAmp® Fast 8-Tube Strip
MicroAmp® Fast Reaction Tube with Cap

O M m O O W > *

MicroAmp® Optical Adhesive Film

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 5
Genotyping Experiments



n Chapter 1 Get Started
About Genotyping Experiments

About Genotyping Experiments

Endpoint
Experiments

About TagMan®
SNP Genotyping

Assays

About TagMan®

Notes

MGB Probes

Genotyping experiments are endpoint experiments. In endpoint experiments:

+ Data are collected at the end of the PCR process.

* Reactions are characterized by the quantity of target sequence accumulated at the end of
the PCR (Saiki ef al., 1985).

 The datapoint is the normalized intensity of the reporter dye, or Rn.

Note: Some endpoint experiments also include pre-PCR datapoints. If so, the system
calculates the delta Rn (ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter

Note: In this guide, the term experiment refers to the entire process of performing a run
using the StepOne or StepOnePlus system, including setup, run and analysis.

Real-Time PCR Data for Endpoint Experiments

The StepOne software provides the option of collecting real-time data for both
presence/absence and genotyping experiments. In the event that an experiment fails, the
real-time data can help you determine the cause of the failure.

A genotyping assay detects variants of a single nucleic acid sequence, without quantifying the
target. The presence of two probes in each reaction allows genotyping of the two possible
variants at the single nucleotide polymorphism (SNP) site in a target sequence.

Each TagMan® SNP Genotyping Assay consists of a single, ready-to-use tube containing:
* Two sequence-specific primers for amplifying the polymorphism of interest

+ Two allele-specific TaqMan® MGB probes for detecting the alleles for the specific
polymorphism of interest

Each allele-specific TagMan® MGB probe has:
* A reporter dye at its 5" end
— VIC® dye is linked to the 5" end of the Allele 1 probe.
— FAM™ dye is linked to the 5" end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the
square brackets of the context sequence in the assay information file (AIF) shipped
with each order. The Allele 2 FAM™ dye-labeled probe corresponds to the second
nucleotide inside the square brackets of the context sequence in the AIF. For the
context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe will bind to the
G allele, and the FAM™ dye-labeled probe to the T allele.

* A minor groove binder (MGB), which increases the melting temperature (T ) for a given
probe length, allows the design of shorter probes (Alfonina ef al., 1997, Kutyavin et al.,
1997). The use of shorter probes results in greater differences in T, values between
matched and mismatched probes, and more robust genotyping.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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* A nonfluorescent quencher (NFQ) at its 3" end, allowing for detection of the reporter dye
fluorescence with greater sensitivity than with a fluorescent quencher.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

5" Nuclease The figure below is a schematic depiction of the 5" nuclease assay. During PCR:

Assay + Each TagMan® MGB probe anneals specifically to its complementary sequence

between the forward and reverse primer sites.

*  When the oligonucleotide probe is intact, the proximity of the quencher dye to the
reporter dye quenches the reporter signal.

+ AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic DNA
template.

+ AmpliTaq Gold® DNA polymerase (with its 5" nuclease activity) cleaves probes that
are hybridized to the target sequence.

* Cleavage of the probes hybridized to the target sequence separates the quencher dye
from the reporter dye, resulting in increased fluorescence by the reporter. The
fluorescence signal generated by PCR amplification indicates which alleles are
present in the sample.

1. Assay Components and DNATemplate
GB GB
LN ,
T Probe 7&/ Probe %’
Forward primer V'*ﬁ—‘@ G*EIW Reverse primer
¢ A S R
° DNA templ [G/A] 3
\ template /
3 [cm 5
2. Denatured Template and Annealing Assay Components 5 3 LEGEND
~ V VIC® dye
P )M-G/B )&G/B Reverse primer
robe Probe
e v e o @@ ‘ F) FAM™dye
G A
Forward primer \ /
\ @ Quencher
- (cm S
3 5
Minor Groove
(MCB  Binder
3. Polymerization and Signal Generation Sl ¥ AmpliTag Gold®
______ DNA Polymerase
~ Reverse primer 2
&eG
Probe ==  Probe
A N .
V. == Primer
Forward primer
I N
== Template
Extended Primer
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Minimizing
Non-Specific

Fluorescence

Reading and

Analyzing the

Notes

Plates

In TagMan® assays, fluorescence from nonspecifically bound probes is reduced, because
nucleotide mismatches between a probe and a sequence reduce the chances that the probe
will be cleaved. The probe’s short length means a one base pair mismatch will a have a
larger negative effect on the binding. The mismatched probe will not bind tightly to the
allele, allowing the AmpliTaq® Gold DNA polymerase likely to displace the probe
without cleaving the dye.

The StepOne software genotypes the DNA samples from the reaction plate
simultaneously. First, the software normalizes the fluorescence of the reporter dyes to the
fluorescence of the passive reference dye in each well. Next, the software plots the
normalized intensities (Rn) of the reporter dyes in each sample well on an Allelic
Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific
probes. Finally, the StepOne software algorithmically clusters the sample data, and
assigns a genotype call to the samples of each cluster according to its position on the plot.

Note: The StepOne software clustering algorithm does not call genotypes when only one
genotype is present in an experiment.

45 »

4.0

Allele 2

35

3.0

LI s

24 24 34 24
Allele 1

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis
(Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the
extent of reporter dye fluorescent intensity after PCR amplification. The table below
shows the correlation between fluorescence signals and sequences in a sample.

A substantial increase in... Indicates...
VIC® dye-labeled probe fluorescence only Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only Homozygosity for Allele 2

Both VIC® and FAM™ dye-labeled probes fluorescence Allele 1-Allele 2 heterozygosity
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Supported The StepOne and StepOnePlus systems support the following reagents for genotyping
Reagents experiments:

* TagMan reagents

» Other fluorescence-based reagents
If you use other fluorescence-based reagents on the StepOne and StepOnePlus systems,
note the following:

* You must design your experiment using Advanced Setup instead of the Design
Wizard. (See “Advanced Setup Workflow” on page 100.)

* For Applied Biosystems TagMan reagents, the StepOne software automatically
calculates reaction volumes in the Reaction Setup screen.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide By using the example experiment data provided with the StepOne software, you can use
as a Tutorial this guide as a tutorial for performing a standard curve experiment on a StepOne or
StepOnePlus system. Follow the procedures in Chapters 2 to 5:

Chapter Procedure
2 Design the experiment using the Design Wizard in the StepOne software.
3 Prepare the experiment, using the reagents and volumes calculated by the

Design Wizard in Chapter 2.

4 Run the experiment on a StepOne or StepOnePlus instrument (standalone or
colocated layout)

5 Analyze the results.

For more information, see “About the Example Experiment” on page 10.
Using This Guide After completing the tutorial exercises in Chapters 2 to 5, you can use this guide to lead

with Your Own you through your own genotyping experiments. Each procedure in Chapters 2 to 5
Experiments includes a set of guidelines that you can use to perform your own experiments.

Notes
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Additionally, you can use one of the other workflows provided in the StepOne software to
perform your experiments. The table below provides a summary of all the workflows
available in the StepOne software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. Chapter 2
The Design Wizard walks you through best practices as
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 100

Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 101
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 103
template.
Export/Import Import experiment designs from ASCII text files that page 105

contain experiment setup information.

About the Example Experiment

Description

Notes

10

To illustrate how to perform genotyping experiments, this guide leads you through the
process of designing and analyzing an example experiment. The example experiment
represents a typical setup that you can use to quickly familiarize yourself with a StepOne
or StepOnePlus system.

The objective of the example genotyping experiment is to investigate SNP rs8039, where
possible genotypes are AA, AC, and CC. In the example, 20 unknown genomic DNA
(gDNA) samples were genotyped using TagMan® Drug Metabolism Genotyping Assay
ID C__11711420_30. The reactions were set up so that the PCR primers and probes that
target both alleles of SNP rs8039 were present in the same well. The PCR was performed
using the TagMan® Universal PCR Master Mix and run according to the protocol that is
described in the Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well
Plates Quick Reference Card.
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Reaction Plate The genotyping example experiment was created for a StepOne instrument. For the
Layout StepOne instrument, the software displays a 48-well reaction plate layout:

| Elshowmv\lellsv | ViewLegend

1

2 [ 3 4 5 [ 6 [

N Sample 1 Sample 10 Sample 11 Sample 12 Sample 13 Sample 14
[de_mrraze.. [Je_1trrrazo.. @ c_11711420.. [ c_11711az0.. [ c_11711az0.. [0 c_11711az0.. [0 c_11711azo.. [ c_t1711a20

Sample 18 Sample 18 Sample 17 Sample 18 Sample 10 Sample2 Sample 20 Sample 3
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You can create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the 48-well reaction plate layout shown throughout
this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate
layout:

17|
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About the In this getting started guide you will use two files:

Example Data + In Chapter 2, you will create a genotyping example experiment file that contains
setup data and save it to the experiments folder on your computer:
<drive>:\Applied Biosystems\<software name>\experiments\

Genotyping Example.eds
* In Chapter 5, you will view results in a genotyping example experiment file that

contains run data. The data file for the example experiment installs with the
StepOne software. You can find the data file for the example experiment on your

computer:
<drive>:\Applied Biosystems\<software name>\experiments\examples\
Genotyping Example.eds

Notes
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About the Example Experiment

where:

* <drive> is the computer hard drive on which the StepOne software is installed. The

default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

Data Files in the Examples Folder

The examples folder contains several data files that you can reference when analyzing

your own data, as listed below. The data files install with the StepOne software.

Note: Be sure to use the Genotyping Example.eds file when performing the tutorial
procedures in this guide. The 96-Well Genotyping Example.eds file is a different

example of the genotyping method.

StepOne Instrument

StepOnePlus Instrument

Comparative CT Example.eds

96-Well Comparative CT Example.eds

Comparative CT Study Bio Replicates
Example.edm

Comparative CT Study Example.edm

Genotyping Example.eds

96-Well Genotyping Example.eds

Multiplex Example.eds
Presence Absence Example.eds

Relative Standard Curve Example.eds

RNase P Experiment.eds
Standard Curve Example.eds

SYBR Example.eds

96-Well Multiplex Example.eds

96-Well Presence Absence Example.eds

96-Well Relative Standard Curve

Example.eds

96-Well RNase P Experiment.eds
96-Well Standard Curve Example.eds
96-Well SYBR Example.eds

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Example Experiment Workflow

About the The following figure shows the workflow for the genotyping example experiment.
Experiment

Workflow Start Experiment
v

Design the Experiment (Chapter 2)

Create a new experiment.

Define the experiment properties.
Define the methods and materials.
Set Up the SNP assays.

Set Up the samples and replicates.
Set Up the run method.

Review the reaction setup.

Order materials for the experiment.

© ® N gk~ 0D~

Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

1. Prepare the sample dilutions.
2. Prepare the reaction mix.

3. Prepare the reaction plate.

v
Run the Experiment (Chapter 4)

Prepare for the run.

(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o Dd =

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 5)

View the allelic discrimination plot.
View the plate layout.

View the results in a table.

View the quality summary.

View the raw data plot.

View the multicomponent plot.
View the amplification plot.

View the analysis settings.

Publish the data.

© ©® N ook~ DN

v

End Experiment

Notes
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Example Experiment Workflow

Notes
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Chapter 2

Design the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 16
B Createa New Experiment. . .. ......... .. 17
B Define the Experiment Properties .. ........ ... .. .. ... .. .. .. .. ... ... 19
B Define the Methods and Materials . . ......... ... .. .. ... 21
B Set Upthe SNP ASSays. . ..ot e e e e 23
B Set Up the Samples and Replicates. . ........... ... ... .. ... ... 25
B SetUpthe RunMethod ......... .. ... .. .. ... . . . . 27
B Review the Reaction Setup. ........... i 29
B Order Materials for the Experiment .. ............. .. ... .. ..., 32
B Finish the Design Wizard .. ...... ... .. i 35

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™" Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne"™ software to set up
the genotyping example experiment. The Design Wizard walks you through Applied
Biosystems recommended best practices as you enter design parameters for the example
experiment.

Workflow The workflow for designing the example experiment provided with this getting started
guide is shown below.

Note: Design the example experiment using the Design Wizard in the StepOne software.
When you design your own experiments, you can select alternate workflows (see “Using
This Guide with Your Own Experiments” on page 9).

Start Experiment
v

Design the Experiment (Chapter 2)

Create a new experiment.

Define the experiment properties.
Define the methods and materials.
Set Up the SNP assays.

Set Up the samples and replicates.
Set Up the run method.

Review the reaction setup.

Order materials for the experiment.

© ©® N o kN~

Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

Notes
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

Log Intothe 1. Double-click € (StepOne software) or select Start » All Programs » Applied
Software and Biosystems » StepOne Software » <software name>
Crea_te an where <software name> is the current version of the StepOne software.
Experiment

2. In the Login dialog box, create a user name:

a. In the User Name field, enter EXAMPLEUSER. You cannot enter spaces in
the User Name field.

b. Click OK.

Loginas Guest [l Delets User(s)

3. From the Home screen, click (Design Wizard) to open the Design Wizard.

IFi\e Edit Instrument Analysis Tools Help I

[E] Mew Experiment - =] Open.. [ [ TJ_“ Send Experiment to Instrument... L_'r Download Experiment from Instrument.. &30 8

Notes
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Create a New Experiment

Design  When you design your own experiment, you can do one of the following in the Login

Guidelines dialog box:

* Log in as a new user — In the User Name field, enter a user name, then click OK.

Note: You cannot use the following characters in the User Name field: space,
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*),
question mark (?), quotation mark ("), vertical line (]), colon (:), or semicolon (;).

* Log in as an existing user — From the User Name dropdown menu, select an existing
user, then click OK.

* Log in anonymously — Click Log in as Guest.

Applied Biosystems recommends that you log in with a user name. If you log in with a
user name, you can set preferences in the software. The next time you log in to the
software with the same user name, the software uses the preferences you set as the

defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.

You can set preferences as follows:

* Save as the default checkboxes — Select the Save as the default checkboxes as
needed. The Save as the default checkboxes appear on the Home screen, on the
Export Data dialog box, and on several Analysis screens.

* Preferences dialog box — Select Tools » Preferences to open the Preferences dialog
box. In the Defaults and/or Startup tabs, change the preferences as desired.

= Preferences
Defaults | Startup &

x|

Sample Reaction vol.:
Data Falder:

Import Folder.

Export Falder:

Instrument Type:

S\pplied BiosysternsiStepOne Software v2 1lexperiments
\Applied BiosystemsiStepOne Software v2.1lexperiments
S\pplied BiosysternsiStepOne Software v2 1lexperiments

a Enter a default sample volume for your experiments, select your default folders, and
selectthe type of instrument for the sofware to use by default

20 uL

oK || cancel

For More For more information, access the StepOne Software Help by clicking @ or pressing F1.

Information

Notes
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Define the Experiment Properties

Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

Complete the 1. Click the Experiment Name field, then enter Genotyping Example.

Screen .

2. Leave the Barcode field empty.
Note: The MicroAmp® Fast Optical 48-Well Reaction Plate does not have a
barcode.

3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Genotyping Getting Started Guide.

5. Select StepOne™™ Instrument (48 Wells).
Note: The example experiment was created for a StepOne instrument. You can
create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the layout shown in this guide. The software
displays a 48-well reaction plate layout for the StepOne instrument and a 96-well
reaction plate layout for the StepOnePlus instrument. To create the example
experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument
(96 Wells).

6. Select Genotyping for the experiment type.

7. Click Next >.

1A. Define: Experiment Properties Experiment Properties Help @

ﬂ Instructions: Enter identifying infarmation, then selectthe type of experiment to design.

How do you want to identify this experiment? = Required

1 — 1 * Experiment Name: |Gen0hrpmg Example ‘
2 — o Barcode (Optional): | |
3 — I User Name (Optional): | Example User |
4 —— Comments (Optional): |Genotyping Getting Started Guide ‘

~
g

Which instrument are you using to run the experiment?

5— ; |
[ StepCnePlus™ Instrument (96 Wells) ] ‘ ¥ StepOne™ Instrument (48 Wells) ]
Setup, run, and analyze an experiment using a 3-color, 48-well system.
6 ; |
[ Quantitation ] ‘ + Genotyping ] [ Presence / Absence }
Design a genotyping experiment to detect single nucleotide polymorphism variants of a target nucleic acid sequence in a sample.
Notes
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Design  When you design your own experiment:
Guidelines  Enter an experiment name:
— The experiment name is used as the default file name.

— Enter a name that is descriptive and easy to remember. You can enter up to 100
characters in the Experiment Name field.

Note: You cannot use the following characters in the Experiment Name field:
forward slash (/), backslash (), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (), colon (),
semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@),
circumflex ("), left parenthesis ( (), right parenthesis () ), or exclamation

point (!).

IMPORTANT! If you will run the instrument in standalone mode from the
instrument touchscreen, you cannot enter more than 32 characters in the
Experiment Name field and you cannot include spaces in the name.

(Optional) If you use a MicroAmp® Fast Optical 96-Well Reaction Plate, enter a
barcode of up to 100 characters to identify the reaction plate that you use in the
experiment.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

L]

(Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

(Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.

* Select the instrument you are using to run the experiment:

— StepOne™ Instrument (48 Wells)

— StepOnePlus'” Instrument (96 Wells)

Note: You can use StepOne Software v2.1 or later to design experiments for both
the StepOne and StepOnePlus instruments. The instrument you select in the
Experiment Properties screen affects the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
General tab (default). From the Default Instrument Type dropdown menu, select the
appropriate instrument. To change the default instrument type, you must be logged
into the software with a user name, not as a Guest. For more information, see the
“Design Guidelines” for logging in on page 18.

* Select Genotyping as the experiment type.

Notes
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Define the Methods and Materials

For More For more information on:

Information * Completing the Experiment Properties screen, access the StepOne Software Help by
clicking @) or pressing F1.
» Consumables, see “Supported Consumables” on page 4.

* Quantitation experiments, refer to the Applied Biosystems StepOne™" and
StepOnePlus™ Real-Time PCR Systems Reagent Guide.

Define the Methods and Materials

On the Methods and Materials screen, define the:
* Reagents that you are using to genotype samples
+ State (wet or dry) of DNA template that you are genotyping
* Ramp speed best suited for the PCR reactions

» Stages to include in the method

About the The example experiment uses TagMan® reagents and wet genomic DNA (gDNA)
Example Design template in the PCR reactions. Because the reactions do not contain TagMan® Fast
reagents, the StepOne or StepOnePlus system performs the run using the standard ramp
speed. Also, because the instrument performs the thermal cycling for the PCR, the run
method for the experiment consists of Pre-PCR Read, Amplification, and Post-PCR Read
stages.

Complete the 1. Select TagMan® Reagents for the reagents.

Screen
2. Select Wet DNA (gDNA or ¢cDNA) for the template type.
3. Select Standard (~2 hours to complete a run) for the ramp speed.
4. Select Pre-PCR Read and Amplification to add the stages to the run method.
Note: The Post-PCR read is required.
5. Select Next >,
Notes
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Define the Methods and Materials

1B. Define: Methods & Materials Methods & Meterials Help €))

@ instructions: Selsctihe reagents, select the typs of DNAtemplate to use, select the stages for the instrument run, then review the instrument ramp speed for this genotyping experiment

Which reagents do you want to use for genotyping?

1 He== wpe——— I = ]
The PCR reactions contain two primers and two TagMan® probes. The primers are designed to amplify the sequence containing the SNP. Each TagMan probe is designed to hybridize to one allele sequence and generate fluorescence signal when the allele sequence is amplified.
What type of template do you want to use in the PCR reactions?
2 = 7 Wt A (A o corvA) X 50,00 GO oD J
Yo 31 A1 54336 A0 1 1l 36001, U 8 ISR 0 451 1 DA, T, 13K 5491 AZGOZE 10 51 131 1.7 1 DNA 1083 oRctan PR VBTS00 0 S GHTSts Shows 1 ONAIS W, 1 DNAa ot bosn et
above 60 °C.
Which ramp speed do you want to include in the instrument run?
3 i T X e ]
For 148U 1 s S, By S ST S PR ctone

Which stages do you want to include in the instrument run?.

4 T

Design  When you design your own experiment:

Guidelines + Select Other if you are not using TagMan® reagents to amplify and detect the target

sequences in your experiment.

Note: The Reaction Setup screen is not available if you select Other.

* Ifyou use a template other than genomic DNA (gDNA) or cDNA, select the option
(Wet DNA or Dry DNA) that describes the state of your samples.

 Select the appropriate ramp speed for the instrument run:

— Select Fast (~ 40 minutes to complete a run) if you use fast reagents for the
PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you use standard reagents for
the PCR reactions.

+ If you are going to perform the PCR amplification on a thermal cycler other than a
StepOne or StepOnePlus system, deselect the Amplification option.

Note: The pre-PCR read is optional, but recommended. The StepOne software uses
the pre-PCR read to normalize the post-PCR data.

For More For more information on:

Information * The Materials & Methods screen, access the StepOne Software Help by clicking @)
or pressing F1.

* Advanced Setup, see “Advanced Setup Workflow” on page 100.

Notes
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Set Up the SNP Assays

Set Up the SNP Assays

On the Set Up SNP Assays screen, enter the number of SNP assays in the experiment,
then define the properties for each SNP assay.

About the The example experiment evaluates samples for SNP rs8039. Because the assay is a
Example Design TagMan® Drug Metabolism Genotyping Assay (Assay ID C__11711420_30), the SNP
assay information can be imported from the Assay Information File (AIF) shipped with
the assay, or downloaded from the Applied Biosystems website.

Complete the 1. For the number of SNP assays being studied, enter 1.
SNP Assays .
Screen 2. Click Yes (Select SNP Assay from Library).
3. Click Select SNP Assay(s) from Library.
4. Click Import AIF, then use the Import SNP Assays from AIF dialog box to import
the SNP assay from the AIF:
a. Navigate to:
<drive>:\Applied Biosystems\<software name>\experiments\examples
b. Select Text Files (*.txt) from the Files of type dropdown list.
c. Select DME_SNP_185457113_426781-1.txt.
d. Click Import.
% Import SNP Assays from AIF
Loakin: |® examples -i 13.3\315 4a
u.§ 4c
©;
M D) it:
o
(5] Filename: | DME_SNP_185457113_426781-1 54 | [ mpo 21— 4d
My;l::::rk Files oftype: ‘TextFiles (*.bat) v| ‘ Cancel
|
\ 4b
5. In the Import SNP Assays dialog box, click OK.
6. Select the C__11711420_30 SNP assay.
7. Click Use Selected SNP Assay(s).
8. Select Next >,
Notes
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2A: Set Up: SNP Assays

SMP Assays Help @

ﬂ Instructions: Enter the number of SMP assays to run in the reaction plate, then setup the properties for each SNP assay.

Set Up SNP Assays

1 « How many SNP assays are you studying in this experiment?
« Have you ordered and received the assay and the assay information file (AIF) for each SHP assay?
2 |r ¥ Yes (Select SNP Assay from Library) ][ Mo (Set Up SNP Assay Properties Manually) }
MOTE: Import the AIF into the SKP Assay Library before you set up the SMP assay properties.
Click"Select SMP Assay(s) from Library' to open the SNP Assay Library. Ifthe SMP assay is not in the library, import the AIF inta the library. Then,
3 selectthe SMP assay(s) to setup the SNP assay properties.
SNP Assay1 | Select SNP Assay(s) from Library
SNP Assay Name:| G__11711420_30 | color[ I v assayio: | [ Fina
Allsle 1 Name: [ A | color [ | Reporer[vic ~|  auencher|nFa-uce v
Allele 2 Name: ‘C | Cu\nr,i V| Reporter |FAM v‘ Quencher|NFQ—MGE v‘
SNP Assay Library
Add new SNP assays, edit existing SNP assays, delete SNP assays, import SMNP assays from a text file or an AIF, or export SNP assays to a text file. Apply a filter to reduce the number of SNF assays @)
displayed
Enter a filter query, then click "Apply Filter” To enter multiple filter queries, click "Advanced Filter" | Advanced Fiter
IF [P Assay | [ | [ Ay Fiter | | =
4 ‘ 1
| New | Edit | Delete | Delete Al ||| Import | Import AIF M Export | ‘
SMP Assay Allele 1 Name Allele 1 Reporter | Allele 1 Quenc Allele 2 Name Allele 2 Reporter | Allele 2 Guenc. Color Comments Created On Last Modified
6 ___ 11711420_30 ]A |VIC |NFQ-MGB |C |FJ\M ‘NFQ-MGB ‘ . | Sep 22, 2006 Apr 16, 2007
Import SNP Assays E|
‘::l,) Successfully imported 1 items,
5 (o]
Use Selected SHP Assay(s) J | Exit SMP Assay Library
7
Design  When you design your own experiments:
Guidelines * Applied Biosystems recommends that you evaluate no more than six SNPs on a
reaction plate.
Note: The Design Wizard allows no more than two SNPs per plate. Advanced Setup
or Quickstart do not restrict the number of SNPs you can evaluate.
* Identify each SNP assay with a unique name and color.
» If you do not choose to set up your SNP assays manually, make certain that the
reporter dyes you assign to each allele are correct.
IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne™™ system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus™ system.
Notes
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Set Up the Samples and Replicates

» After saving your experiment, you can edit the SNP assays if needed:
a. Open the saved experiment.

b. From the Experiment Menu pane, select Setup » Plate Setup.

Note: Ifyou edit an allele name, the new name appears in the Well Table and in
published reports. In addition, the name you enter for Allelel corresponds to
the x-axis in the plots; the name you enter for Allele 2 corresponds to the y-axis
in the plots.

For More For more information on:

Information » The Targets SNP Assays screen, access the StepOne Software Help by clicking
@) or pressing F1.

» Editing SNP assays in the Plate Setup screen, access the StepOne Software Help by
clicking ) or pressing F1.

Set Up the Samples and Replicates

On the Set Up Samples and Replicates screen, enter the number of samples in the
experiment, enter sample names, then enter the number of negative and positive controls.

About the The example experiment evaluates:
Example Design ¢ 20 unknown samples
* 2 negative controls
» 2 positive controls (a heterozygote and an Allele 2 homozygote).

Complete the 1. For the number of samples, enter 20.
Samples and

Replicates 2. For the number of replicates, enter 1.
Screen 3. Click All Sample/SNP Assay Reactions.
4. For the number of negative controls (wells that contain no template), enter 2.
5. For the number of positive controls (wells that contain samples of known
genotypes), enter 2.
6. For Positive Control 1, select Allele 1/Allele 2 Heterozygous.
7. For Positive Control 2, select Allele 2 Homozygous.
8. Select Next >.
Notes
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2B. Set Up: Samples & Replicates Samples & Replicates Help @)

—_

B Instructions: Enter the number of samples to test in the reaction plate, enter sample names, then enter the number of negative and positive controls.

Set Up Samples & : View Plate Layout

+ How many samples do you want to testin the reaction plate? 20 Arrange Plate By: [Rows  + | Place Controls in: (UpperLeft
« How many replicates do you need? 1 =

2 Elsvmwm Wells ¥ VIEW Legend
For each sample in the reaction plate, enter a sample name and selecta sample color.

* Enter Sample Name

Color oz s [ e T e 7 [ s ]

|SamnI91

~
| Sample 1 Sample 10 Sample 11 Sample 12 Sample 13 Sample 14

|Samn|e 2

[Te_trm. [Te_a1m. 1171 [@c_117. [@e_17a. [ c_1171. [ c_1171. [l c_1171

| v

|Samn|e 3

| v

Sample 15 Sample 16 Sample 17 Sample 18 Sample 19 Sample2  Sample20  Sample3

v B

I c_1a7e. @ c_117a. @ c_ta7a. @ c_a17e. @ c_1a71. [@ 1171, @ c_aa7a. [@ c_171.

Which sample/SNP assay reactions do you want to set up? :
Sample 4 Sample 5 Sample 8 Sample 7 Sample 8 Sample 8

3 } + All Sample/SNP Assay Reactions ‘[ Specific Sample/SHNP Assay Reactions ]

1171 [@c_117. [@e_17a. [ c_1171. [ c_1171. [l c_1171 B e Ee_tm.

~NOo O~

D
Set Up Controls

*How many neaative controls do you need for each SNP assay? 2
(Optional) How many positive controls do you need for each SMP assay? 2
Select Positive Control 1 Genotype: |Allsle 1/Allele 2 Heterozygous +

Select Positive Control 2 Genotype: Allele 2 Homozygous - F

<

Design
Guidelines

When you design your own experiment:

L]

Use between:

— 1 and 48 samples for the StepOne instrument

— 1 and 96 samples for the StepOnePlus instrument
Enter a unique name and color for each sample.

Applied Biosystems recommends using at least one negative control for each SNP
assay.

Limit the number of total reactions in each experiment to 48 or less. If the number of
total reactions required is greater than 48, reduce the number of SNP assays,
samples, replicates, or positive and negative controls; or divide the reactions
between two or more reaction plates.

If you are running the experiment on a StepOnePlus instrument and plan to edit the
Run Method (page 27) to set a different temperature for one or more of the VeriFlex
blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen, select the View Plate Layout tab, then select the
Enable VeriFlex" Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in the
Plate Setup screen, you will not be able to set a different temperature for one or
more of the VeriFlex blocks in the Run Method screen (page 27).

For More For more information on the Samples & Replicates screen, access the StepOne Software
Help by clicking ) or pressing F1.

Information

Notes
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Set Up the Run Method

Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the The example experiment runs 25-uL reactions using the TagMan® Drug Metabolism
Example Design  Genotyping Assay method shown below. Because the StepOne system is used to perform
the thermal cycling, the run method contains a Cycling stage for the PCR.

Pre-PCR . Post-PCR
Read Thermal Cycling Read
Holding Holding Cycling (50 cycles) Holding
Stage/Step St St St
age age Denature Anneal/Extend age
Temperature 60 °C 95 °C 92 °C 60 °C 60 °C
Time (mm:ss) 00:30 10:00 00:15 01:00 00:30
Data Collection Yes No No Yes Yes

Note: In the method above, data collection is activated for the Anneal/Extend step so that
the instrument collects real-time data during the PCR. Although the real-time data are not
necessary for genotyping, the data can be useful when troubleshooting failed PCR.

—h

Review the Run . Click the Reaction Volume Per Well field, then enter 25.

Method Screen . _ .
2. Click the Number of Cycles field of the Cycling Stage, then enter 50.

3. Adjust the first step of the Cycling Stage: Click the temperature setting (95 °C),
then enter 92 °C.

4. Adjust the second step of the Cycling Stage: Click the time setting (01:00), then
enter 01:30.

5. Click Next >.

Notes
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2C. Set Up: Run Method

Fun Method Help @)

a Instructions: Review the reaction volume and the default thermal profile for the stages you selected for the instrument run. If needed, change your selection, edit the run method, or select a run method from the library.

1 Reaction Valume Per Well

( Graphical ViewT Tabular View 1

25.0 gL

Add Stage ¥ | Add Step ¥ ‘

‘ Undo "Set Hold Time"

|| CollectData ¥ M Open Run Method | Save Run Method

Revertto Defaults

Include: [4] Pre-PCR Read [#] Amplification

Pre-PCR Read (Holding Stage)

Holding Stage

Cyeling Stage

Post-PCR Read (Holding Stage)

2 Mumber of Cycles: 50 F
[[]Enable AutoDelta
Starting Cycle
3 100 — asnec oz
10:00 00 01z
7 0% i
60.0°C 60.0°C 60.0°C
4 £ 00:20 01:30 100%  pog
oo ]
25 —
o —|
Step 1 Step 1 Step 1 Step 2 Step 1
< >
Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off
Design  When you design your own experiment:

Guidelines .

Notes
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reaction volume of 25 pL for genotyping experiments.

Enter a reaction volume/well of 10 to 30 uL. Applied Biosystems recommends a

* Review the default run method. If your experiment requires different settings, edit
the default method as needed.

¢ Click Open Run Method to view a library of run methods. The library may contain
the run method for your experiment.

» Consider including amplification in the run method. Real-time data can be useful
when troubleshooting a genotyping experiment.

» If you are running the experiment on a StepOnePlus instrument and you want to set
a different temperature for one or more of the VeriFlex blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen (page 26), select the View Plate Layout tab, then
select the Enable VeriFlex"" Block checkbox.

c. In the Run Method screen, select the Graphical View tab.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen.
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Review the Reaction Setup

d. For each VeriFlex " block you want to change, click the temperature, then enter
the desired value.

Note: You can set a different temperature for one or more of the VeriFlex blocks, or
set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex
blocks are not set to the same temperature, the temperature difference must be
between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

For More For more information on:

Information * The Run Method Library or on completing the Run Method screen, access the
StepOne Software Help by clicking @) or pressing F1.

» Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by
clicking @) or pressing FI.

» Using Advanced Setup, see “Advanced Setup Workflow” on page 100.

Review the Reaction Setup

On the Set Up Reaction Setup screen, enter the reaction volume and the number of excess
reactions to prepare, then review the concentration settings for the PCR master mix,
assay mix, diluted sample target, and sample stock(s), and make changes as necessary.

About the The example experiment requires sufficient reaction mix for 24 reactions and a
Example Design 10 percent volume for pipetting error. Each 25-uL reaction consists of the following:

Component pL/Well
2X TagMan® Universal PCR Master Mix, No AmpErase® UNG 12.50
20X TagMan® Drug Metabolism Genotyping Assay 1.25
Genomic DNA template (3 to 20 ng) + DNAse-free water 11.25
Total volume 25.00
Complete the 1. Click the Reaction Volume Per Well ficld, then enter 25 uL.
Reaction Setup . ) .
Screen 2. Click the Excess Reaction Volume field, enter 10%.
3. Confirm that the master mix concentration is 2.0X.
4. Confirm that the assay mix concentration is 20.0X.
Notes
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Notes
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2D. Set Up: Reaction Setup Reaction Setup Help @

For each SNP assay in the reaction plate, review the calculated volumes for preparing the PCR reactions. If needed, editthe reaction volume, excess reaction volume,

Instructions:
“ component concentrations, andior stock concentrations. Click "Print Reaction Setup” to printinstructions on how to prepare the PCR reactions
| Print Reaction Setup

T ReactionVolume Per Well uL
T Excess Reaction Valume %

’LReacﬁon Mix Calculations T Sarnple Dilution Calculations ]

elect SNP Assay Reactions for SNP Assay 1
C__11711420_30

Master Mix Concentration: X

Assay Mix Concentration: X

Component Wolume (uL) for 1 Reaction Volume (uL) for 8 Reactions (Plus Excess)
Master Mix (2 10.00 88.00
1.00 8.80
2.00 17.60
Water 7.00 61.60
Total Volume 20.00 176.00

5. Select the Sample Dilution Calculations tab.

6. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then
enter 30 ng/uL.

7. Confirm that the stock concentration of all samples are 100ng/uL.

8. Print a report of the plate layout for reference:
a. Click Print Reaction Setup.

b. In the dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout
* Use sample color

c. Click Print to send the reaction setup instructions to your printer.

9. Click Next >.
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Review the Reaction Setup

2D. Set Up: Reaction Setup Reaction Setup Help @
n Instructions: T 07 #ach SNP assay inthe reaction plate, review the calculated volumes for preparing the PCR reactions. If needed, edit the reaction volume, excess reaction volume,
" component concentrations, andior stock concentrations. Click "Print Reaction Setup” to print instructions on how to prepare the PCR reactions
8a | Print Reaction Setup
Reaction Volume Per Well uL
5 Fyress Reaction Valume 10| % |
Reaction Mix Calculations || Sample Dilution Calculations |
6 —{ Diuted Sample Concentration (1 0x for Reaction M- | 30.0 T
Sample Mame Stock Concentration (ng/uL) Sample Volume (uL) Diluent Volume (uL) Total Volume of Diluted Sampl
7 Sampiet | 100.0 \‘ 0.66 1.54 220 e
Sample 10 [ 100.0 | 086 1.54 220
Sample 11 1008y Reaction Setup 0 220
Sample 12 10 220
— a Selectthe type of reaction setup instructions to print
Sample 13 10i 220 o
Sample 14 ’710 ) summary Reaction Setup Instructions 290
(® Detailed Reaction Setup Instructions
Fample 18 —(8b" @i e 220
Sample 16 10, Select Plate Layout Color 220
Sample 17 ‘ Joo— @ Use sample color 29
| O Use task color bt
‘ Preview | Prinit ‘ Cancel

Design  When you design your own experiment:

Guidelines » Enter a reaction volume/well of 10 to 30 pL. Applied Biosystems recommends a
reaction volume of 25 pL for genotyping experiments.

* Enter an excess reaction volume of at least 10 percent to allow for pipetting
inaccuracies and other experimental error.

* Ifyou use dry DNA template, the components and volumes are recalculated.

For More For more information on the Reaction Setup screen, access the StepOne Software Help
Information by clicking @ or pressing FI.

Notes
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Order Materials for the Experiment

Complete the

Ordering

Materials Screen

Notes

32

On the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your
experiment design. It is assumed that you will design your experiment, order your
materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your
materials arrive.

1. Inthe Enter Gene Name or RS Number field, enter rs8039, then click Find Assay to
get the assay from the Applied Biosystems website:

a. In the Find Assay Results dialog box, select the C__11711420_30 assay.
b. Click Apply Assay Selection.

=
4. Find Assay Results.

1 Results Found for Assay rs8039 Select one of the assays below to associate with rs8039
SMP Type
UTR 3

Gene Symbal | Gene Name " Public Location
CYP51A1 eytachrome P450, family 51, subfamily A, palypeptide 1

AKAPS Akinase (PRKA) anchor protein (yotiao) 9

Availab Assay D

1a —y—Premade  C_ 11711420 30 791580284

Next= | | Last | | Apply Assay Selection | | Cancel
SEEEY (225N i SRR

1b

2. From the Display dropdown menu, select All Items (default), then review the
recommended materials. If needed, use the scroll bar at right to see all items.

Note: For more information on a specific item, click the part number link. You will

be connected to the product information page on Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

3. (Optional) Click Print Materials List to send the materials list to your printer.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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4. (Optional) Create a shopping list:
a. Select the checkbox next to each of the following items:
+ MicroAmp® Fast Optical 48-Well Reaction Plates
+ MicroAmp® 48-Well Optical Adhesive Film
+ MicroAmp® 96-Well Support Base
+ TagMan® Universal PCR Master Mix, No AmpErase® UNG
C__11711420_30

L]

Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 19),
the 96-well consumables (for example, the MicroAmp® Fast Optical 96-Well
Reaction Plate) are listed in place of the 48-well consumables.

b. Click Add Selected Items to Shopping List.

5. (Optional) Create a shopping basket on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Login and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

6. Go to “Finish the Design Wizard” on page 35.

Notes
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3A. Order: Materials List (Optional) Materials List Help 0/

Review the list of materials recommended to prepare the PCR reaction plate. To create a shopping basket on the Applied Biosystems Store, add items to the shopping

Instructions:
a list, enter a name for the shopping basket, click"Order Materials in List" then log in.

Find Assay

1 Enter Gene Mame or RS Mumber ‘ rsB039 | \ Find Assay \ Enter a gene name or RS number to search the Applied Biosystems Store for a SMP assay.

Experiment Materials List 2

4b - Add Selected tems to Shopping List | Display : ‘AII Items v‘ | Print Materials List 3

[ check Al Item Part Number Description

The MicroAmp™ Fast Optical 48-Well Reaction Plate, G
) - g constructed from a single rigid piece of polypropylens in a 48
4a M MicroAmpT™ Fast Optical 48-Wall Reaction Plate L376B1E well format. Increased thermal contact for faster, more uniform
heating v

Experiment Shopping List (4 items)
| 5a

‘ Remowve Selected ttems from Shopping List ‘ Shopping Basket Name | Genatyping Example StepOne ‘ | Order Materials in List |

[ Check All Iltem Part Number Quantity

] MicroAmp™ Fast Optical 48-Well Reaction 4375816 |1

] MicroAmp™ Onptical 48-Well Adhesive Film (.. 4375323 |1 |

Design  When you design your own experiment:

Guidelines + Select all the materials that you require for your experiment and add them to your

shopping list.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes)
with the StepOne and StepOnePlus systems, even when performing an experiment
with standard reagents.

* To access the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader versions to use the Applied Biosystems web site:

Microsoft® Adobe®
Desktop Operating System Internet Acrobat®
Explorer Reader
Windows® XP v6.X v4.0 or later
(Service Pack 2 or Service Pack 3)
Windows® Vista v7.x or later v4.0 or later

IMPORTANT! Make sure that cookies and Java Script are turned on for the web site
to function correctly.

For More For more information on the Materials List screen, access the StepOne Software Help by
Information clicking @) or pressing F1.

Notes
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Finish the Design Wizard

Finish the Design Wizard

On the Review Plate Layout for Experiment dialog box, select an option to finish the
Design Wizard setup, review the plate layout and start the run.

Finish the
Design Wizard

1. At the bottom of the StepOne software screen, click Finish Designing Experiment.

Review the plate layout. If the plate layout is incorrect, select Return to the Wizard
and check your entered values.

Click Save Experiment.
In the Save Experiment dialog box, click Save to accept the default file name and

location. The example experiment is saved and closed, and you are returned to the
Home screen.

Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.

Review Plate Layout for Experiment "Genotyping Example™

a Review the plate layout, then select what you want to do next.
3 ] —| Save Experiment Start Run for This Experiment Edlit Plate Layout Cregte Another.E)(periment Return to the Wizard
| Using the Design Wizard
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard.
El Show in Wells ¥ | View Legend ‘ ‘ |
1 | 2 3 4 5 B 7 | B |
Save Experiment Genotyping Example
5 E— (] Sample 14
D C__11711420.. Save in: |@ experiments v| 15 | == 1420, m c_ 11711420
B Sample 15 My Recent o0 Sample 3
M c_11711az0... | [O |- Bocuments | azo... | [0 c_11711420...
Sample 4 Desktop
C —
) [ c_11711az0.. [ ) razo... | [ c_11711420..
My Documents
D _.—E.
[ | My Computer
E :
- File name ‘ Genotyping Example eds | | save J
My Network
— Places Files of type: ‘ExpenmemDucumemSmg\e files (*.eds) V| | capcel J
F )

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Genotyping Experiments

35



m Chapter 2 Design the Experiment
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Design
Guidelines

When you design your own experiment:

* In the Review Plate for Experiment window, select the appropriate exit option:
Click if you want to...
Save Experiment Save and close the experiment without making any

further changes or starting the run.

Start Run for This Experiment Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

Edit Plate Layout e Use advanced setup to edit the plate layout.

e (StepOnePlus instrument only) Set a different
temperature for one or more of the VeriFlex blocks
using Advanced Setup.

Create Another Experiment Using Save and close the current experiment, then create
the Design Wizard another experiment using the Design Wizard.

Return to the Wizard Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to the <drive>:\Applied Biosystems\<software
name>\experiments folder. To change the:

— Save location for a specific experiment, navigate to the desired location using the
Save Experiment dialog box.

— Default save location, select Tools » Preferences, then select the General tab
(default). In the Default Data Folder field, browse to the desired location.

Note: To change the default save location, you must be logged in to the software
with a user name, not as a Guest. For more information, see the “Design Guidelines”
for logging in on page 18.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on

Information

page 100.
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Prepare the Reactions

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 38
B Prepare the Sample Dilutions . . . ......... .. .. .. . 39
B Prepare the Reaction MiX . . ....... oo i 40
B Prepare the Reaction Plate ........ ... .. .. ... ... .. .. .. . . .. 42

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™" Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.
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Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the genotyping example
experiment and provides guidelines for how to prepare the PCR reactions for your own
genotyping experiments.

Workflow The workflow for preparing the PCR reactions for the example experiment provided with
this getting started guide is shown below.

Start Experiment

v
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

1. Prepare the sample dilutions.

2. Prepare the reaction mix.

3. Prepare the reaction plate.

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

For More For more information on preparing TagMan® SNP Genotyping Assays, see:
Information »  Custom TagMan® SNP Genotyping Assays Protocol
» Custom TagMan® Genomic Assays Protocol
s TagMan® SNP Genotyping Assays Protocol
» TagMan® Drug Metabolism Genotyping Assays Protocol

s Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick
Reference Card

s Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates
Quick Reference Card

* Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol

* Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference
Card

Note: The procedures in this chapter focus on the use of wet DNA samples. If you are

using dried DNA, consult the chemistry protocol accompanying your PCR kit for details
on reconstituting and plating your samples for use.

Notes
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Prepare the Sample Dilutions

Prepare the Sample Dilutions

About the
Example
Experiment

Required
Materials

Prepare the
Samples

Preparation

Dilute the sample stock to working concentrations using the volumes calculated by the
StepOne software (see “Review the Reaction Setup” on page 29).

The calculated volumes for the genotyping example experiment are listed below. The
final concentration is 30.0 ng/uL.

Vol L
Sample Stock olume (uL)
Sample .
Tube Concentration .
Name (ng/uL) Sample DNAse-free | Diluted Sample
Stock (uL) Water (pL) Total (pL)

1 Sample 1 100.0 0.66 1.54 2.20
2 Sample 2 100.0 0.66 1.54 2.20
21 Sample 21 100.0 0.66 1.54 2.20

* DNAse-free water to dilute the sample
* Microcentrifuge tubes

 Pipettors and pipette tips

* Sample stock

» Vortexer

* Centrifuge

1. Label a separate microcentrifuge tube for each sample: Sample 1, Sample 2,...
through Sample 20.

2. Add 1.54 uLL DNAse-free water to each empty tube.
3. Add 0.66 uL of the appropriate sample stock to each tube.

4. Vortex each diluted sample for 3 to 5 sec, then briefly centrifuge the tube(s).

When you prepare the samples for your own experiment:

Guidelines * Use DNAse-free water to dilute the samples.
* Use the same quantity of DNA per well for each experiment.
* Do not heat the DNA samples.
For More For more information on preparing TagMan® SNP Genotyping Assays, refer to the
Information protocol appropriate for the reagents you are using in the PCR reactions (see “For More
Information” on page 38).
Notes
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Prepare the Reaction Mix

Prepare the Reaction Mix

Prepare the reaction mix for the experiment using the volumes calculated by the StepOne
software. The StepOne software determines which reaction mix components to use based
on the selections made in the Methods and Materials screen (see “Review the Reaction
Setup” on page 29). For genotyping experiments, the reaction mix contains all
components except sample, buffer, or positive control.

Required + TagMan® Universal PCR Master Mix, No AmpErase® UNG (2X)
Materials + TagMan® Drug Metabolism Genotyping Assay (20X)

* DNAse-free water

* Microcentrifuge tubes

* Pipettors

* Pipette tips

* Centrifuge

Prepare the ACAUTION CHEMICAL HAZARD. TagMan® 2X Universal PCR Master

Reaction Mix Mix, No AmpErase UNG may cause eye and skin irritation. Exposure may cause
discomfort if swallowed or inhaled. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

1. For the SNP assay, add the required volumes of each component to an appropriately

sized tube:
Reaction Volume

24 Rxns. Including

Component Per Well(uL) 10% Excess (uL)

Dry Wet Dry Wet

TagMan® Universal PCR Master Mix (2X) 12.50 12.50 330 330
SNP Assay Mix (20X) 1.25 1.25 33 33
H,O, DNase-free 11.25 0 297 0
Total Reaction Mix Volume 25.00 13.75 660 363

2. Gently pipette the reaction mix up and down, then cap the tube.

3. Centrifuge the tube briefly.

Notes
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Prepare the Reaction Mix

Preparation  When you prepare the reaction mix for your own experiment, make sure you:
Guidelines * Prepare the reactions for each SNP separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.
* Keep the assay mix protected from light in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.
Prior to use:
* Mix the master mix thoroughly by swirling the bottle.
* Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

» Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

For More For more information on how to prepare the reaction mix, refer to the protocol
Information appropriate for the reagents you are using in the PCR reactions (see “For More
Information” on page 38).

Notes
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Prepare the Reaction Plate

Prepare the Reaction Plate

Required
Materials

Prepare the

Reaction Plate:

Notes

42

Dried gDNA

Load the reaction plate with the reaction mix from page 40 and the dilute samples from
page 39. The reactions are added to wells according to the plate layout generated in the
StepOne software (see “Set Up the Samples and Replicates” on page 25).

N o o A

Centrifuge

MicroAmp® Fast Optical 48-Well Reaction Plate
MicroAmp® Optical 48-Well Adhesive Film
Pipettors and pipette tips

Note: The StepOne and StepOnePlus systems run only MicroAmp® Fast
consumables.

. Pipette 2.5 uL of the appropriate sample (3 to 20 ng of purified genomic DNA) into

each well of a 48-well optical reaction plate.

All wells belonging to the same genotyping assay must contain the same quantity of
sample or control.

Dry down the samples by evaporation at room temperature in a dark, amplicon-free
location. (Cover the reaction plate with a lint-free tissue while drying.)

Transfer 25 pL of reaction mix to each well.

IMPORTANT! Make sure that no cross-contamination occurs from well to well.

Seal the reaction plate with adhesive film.
Vortex the reaction plate for 3 to 5 sec.
Briefly centrifuge the reaction plate.

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect

Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. o Not centrifuged for enough time
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Chapter 3 Prepare the Reactions m
Prepare the Reaction Plate

Dilute 2.5 puL of sample with 8.75 uL of DNase-free water. The volume of DNA
sample and DNase-free water per reaction should be 11.25 pL.

2. Into each well of the reaction plate, pipette one control or sample aliquot of the

o o &~ ©

volume (indicated in step 1) appropriate for the reaction plate type:

a. For each unknown reaction, add 11.25 pL of the sample to the appropriate
wells.

b. For each negative control reaction, add 11.25 uL. of DNAse-free water to the
appropriate wells.

c. For each positive control reaction, add 11.25 pL of the positive control to the
appropriate wells.

IMPORTANT! Make sure the genotype for the positive control template that
you add matches the genotype assigned to the well.

Transfer 13.75 puL of reaction mix to the appropriate wells.
Seal the reaction plate with optical adhesive film.
Vortex the reaction plate for 3 to 5 sec, then briefly centrifuge it.

Centrifuge the reaction plate briefly.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect

Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. & Not centrifuged for enough time

Preparation When you prepare the reaction plate for your own experiment:

Guidelines .

L]

L]

Notes

Make sure you use the appropriate consumables.

Make sure the reaction locations match the plate layout in the StepOne software.

If you are running less than 40 reactions, use tube strips rather than a reaction plate.
Load 3 to 20 ng of purified genomic DNA per reaction

All wells belonging to the same genotyping assay must contain the same quantity of
sample or control.

Multiple assays may be run on one reaction plate, but must be analyzed separately.
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Prepare the Reaction Plate

» If you use optical adhesive film to seal your reaction plates, seal each reaction plate
as follows:

Example
Action
StepOne™ System StepOnePlus™ System

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the
96-well base.

2. Load the reaction plate as desired.

3. Remove a single optical adhesive film (film) from the box. PN

* For the StepOne system reaction plate, bend both end-tabs -
upward. Hold the film backing side up. « g

e For the StepOnePlus system reaction plate, fold back one of
the end-tabs. Hold the film backing side up.

4. In one swift movement, peel back the white protective backing
from the center sealing surface. Do not touch the center
sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may
result in haziness, but will not affect results. Haziness will
disappear when the film comes into contact with the heated cover
in the instrument.

5. Holding the film by the end-tabs, lower the film onto the
reaction plate (adhesive side facing the reaction plate). Be sure
the film is completely covering all wells of the reaction plate.

6. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction
plate.

7. While using the applicator to hold the edge of the film in place,
grasp one end of the end-tab and pull up and away sharply.
Repeat for the other end-tab.

8. To ensure a tight, evaporation-free seal:
a. Repeat step 6.
b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight,
evaporation-free seal.

Notes
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Prepare the Reaction Plate

Example
Action
StepOne™ System StepOnePlus™ System

9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More For more information on how to prepare the reaction plate, refer to the protocol
Information appropriate for the reagents you are using in the PCR reactions (see “For More
Information” on page 38).

Notes
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Prepare the Reaction Plate

Notes
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n Run the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 48
B Prepare forthe Run. .. ... ... ... ... . . 49
B (Optional) Enable the Notification Settings . . . ........... ... ... ... 51
B Startthe Run. . ....... ... 54
B Monitorthe Run . ... ... ... . 58
B Unload the Instrument and Transferthe Data. . ........................... 65

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Start Experiment

h 4
Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

h 4
Run the Experiment (Chapter 4)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o > 0 b=

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 5)

h 4
End Experiment

Notes

48 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments



Chapter 4 Run the Experiment n
Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the StepOne™™ or StepOnePlus™ instrument.

Open the 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Example Biosystems » StepOne Software » <software name>

Experiment where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when designing the
genotyping experiment (page 17).
3. From the Home screen, click Open.

4. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

5. Double-click Genotyping Example to open the example experiment file you
created in Chapter 2.

File Edit Instrument Analysis Tools Help I

3 TEa vew EapenmEnt v L7 Open. [ [ JJ Send Experimentto Instrument.. %, Download Experiment from Instrument... 48 a

Analyze

ﬁ‘ e Experiment

4 om0 experimeants v [ IEEE

| |2 examples

5 " k) Genotyping Example.eds
My Recent

Documenits

My Computer
My Network
Places Files oftype: Al SDS Files (edm; eds; edt)

File name Genotyping Example.eds

Notes
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Prepare for the Run

Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. If the instrument has been used
Into the recently, keep your hands away until the sample block(s) reach room temperature.
Instrument

# IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

StepOne instrument StepOnePlus
sample block instrument VeriFlex™
Sample Blocks

2. Place the reactions in the sample block(s):

» If using a reaction plate: Place the reaction plate in the sample block(s) with
well A1 at the back-left corner.

» If using reaction tube strips: Place the tray containing the tube strips in the
sample block(s).

» Ifusing reaction tubes: Place the tray containing the tubes in the sample
block(s).

Notes
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(Optional) Enable the Notification Settings

IMPORTANT! For optimal performance with partial loads:

StepOnePlus instruments — Load at least 16 tubes and arrange them in:

* Adjacent columns of 8 tubes, using rows A through H. For example, fill wells
in column 1 (rows A through H) and column 2 (rows A through H).

or

* Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells
in row A (columns 3 through 10) and row B (columns 3 through 10).

StepOne instruments — Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

éCAUTION

(Optional) Enable the Notification Settings

Enable the notification settings so that the StepOne software alerts you by e-mail when
the StepOne or StepOnePlus instrument begins and completes the run, or if an error
occurs during the run. You can also set up the software to attach a completed run file to
the Run Completed e-mail notification. Enabling the notifications settings feature is
optional and does not affect the performance of the StepOne™ and StepOnePlus™
systems or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the StepOne or StepOnePlus instrument and is connected to an
Ethernet network.

Note: The notification system is also available to computers that are monitoring a
StepOne or StepOnePlus instrument remotely. For more information, see “Remote
Monitor” on page 62.

About the In the example experiment:

Exgmple * The StepOne software is set up to send notifications to three users (scientist,
Experiment supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus
system ends the run and if it encounters any errors during operation.

e The example SMTP server (www.mycompany.com) is set up for Secure Sockets
Layer (SSL) encryption and requires authentication for use.

Notes
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Set Up the 1. In the StepOne software, click @ Run in the navigation pane.
Notification

Settings . Click B Notification Settings.

Select Yes for Enable Notifications.

A o

Select the events that generate notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. Inthe Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Select No next to “Attach completed runs to message.”

Note: This option applies only to e-mail notifications that are generated when the
instrument completes a run (that is, Run Completed is selected in step 4).

8. Set the authentication settings:
a. Select Yes for Server requires authentication.
b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notification Settings

Enable Notifications: @) Yes () Mo
[ Selectthe events to gensrate natifcations: [ Instrument Error
4 1 [[] Run Started
L [#] Run Gompleted
Enter e-mail addresses for notifications: com, com, com
Separate e-mall aceresses with commas.
For example: jane_ com com
6 Outgoing Mail Server (SMTF): | smtp.mycormpany.com
‘| For example: smip.mycompany.com
7 Attach completed uns to message? () Yes (@) Mo
8a H Server requires an enciypted connection? (O Yes () No
Semver requires authentication? AQ‘VES C‘ND
8b (Server. UserName: | Exarriple User
80 (Server Authentication) Password: [eeseeses
Testthe cutrent parameters,
When you press the "Test Comfiguration” BUHN, | e contiunction
sarmple stattrun, error, and run complete
events will be sent Using the cutrent paramaters.
Notes
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Run Guidelines When you set up the StepOne or StepOnePlus system for automatic notification:

* Your system must be set up for network use. Refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

* Select the events for which you want to receive e-mail notifications:

— Instrument Error — When selected, recipients are e-mailed all errors
encountered by the instrument during each run.

— Run Started — When selected, recipients are e-mailed every time the instrument
starts a run.

— Run Completed — When selected, recipients are e-mailed every time the
instrument completes a run.

¢ Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

» Contact your systems administrator or information technology department if you
need:

E-mail addresses for users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the LAN

A user name and password for the server, if required for access

The Secure Sockets Layer (SSL) setting of the server (on or off)

* Click Test Configuration to test your notification settings. If the notification
settings are set up correctly, sample e-mails are sent to the addresses you entered.

Notes
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Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Startup”
instrument below
Standalone e The computer and the instrument are not “Standalone Startup”
connected, or on page 55
e The computer and the instrument are
connected to the same network.

Colocated Perform this procedure if your computer is directly connected to your StepOne or
Startup  StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click % Run in the navigation pane.

2. Click START RUN .

1 YR Instrument Status: @& Connected

Run Status:  Not Started Enable Notifications

Notes
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Standalone Perform these procedures if your computer and StepOne or StepOnePlus instrument are
Startup not directly connected by the yellow cable. Start with:

* “Send the Experiment to the Instrument Over the Network™ on page 55 if your
computer and instrument are connected to the same network.

or

* “Transfer the Experiment to the Instrument Using a USB Drive” on page 55 if your
computer and instrument are not connected to the same network.

Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click %] Send Experiment to Instrument.

2. In the Send Experiment to Instrument dialog box:
a. Click Browse, navigate to the example experiment file, then click Open.
b. Select the instrument to receive the experiment file.
Note: If your instrument is not listed, set up the instrument for monitoring as

explained in the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time
PCR Systems Installation, Networking, and Maintenance Guide.

c. Click Send Experiment to send the experiment to the your instrument over the

network.
Send Experiment to Instrument g|
a Selectan experimentto send, selectthe instrument to receive the experiment, then click
"Send Experiment” OJ
2a —1 1 select Experiment | Browse
2b 1 2 Selectinstrument. % Local Instrument (Default) v

20 : Send Experiment | Cancel

3. When prompted, click OK to close the confirmation.

4. Go to “Start the Instrument Run Using the Touchscreen” on page 56.

Transfer the Experiment to the Instrument Using a USB Drive
1. Connect the USB drive to one of the USB ports on the computer.
2. 1In the StepOne software, select | Save » Save As.

3. In the Save dialog box, navigate to the USB drive, then click Save.

Notes
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4. Remove the USB drive from your computer, then connect it to the USB port of your
StepOne or StepOnePlus instrument.

5. Go to “Start the Instrument Run Using the Touchscreen” below.
Start the Instrument Run Using the Touchscreen
1. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

Wait for the USB sign to appear on the touchscreen.
In the Main Menu screen, touch Browse/New Experiments.

In the Browse screen, touch {fZ) Folders.

a » 0O DN

In the Choose an Experiment Folder screen:
* Touch USB if you transferred the experiment on a USB drive.
* Touch Default if you sent the experiment over a network connection.
6. Before starting the run, save the example experiment to your instrument:
a. In the Browse screen, touch the example experiment name, then touch Copy.

b. In the Save Experiment screen, navigate to a destination folder, then click
Save & Exit.

7. In the Browse screen, touch the example experiment name, then touch
[ Start Run.

Notes
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( ﬁ) Browse Last Accessed Experiments (1)
4
Experiment I Folder I Last Used * D'

R o ple Experiment

Transfer

Page
111

6a —

LX)

r (elwlzlels] -

Start Run Mew View/Edit Copy Delete

Touch an experiment to select it, then touch
any of the buttons to perform an action.
Touch a column title to sort the table.

8. In the Run Parameters screen:

a. Touch the Reaction Volume field, use the keypad to enter the reaction volume
for the example experiment, then touch Done.

b. Touch Start Run Now.

(‘ ﬁ) Experiment Parameters

8a Reaction Volume: Iz5 uL

Cover Temperature: |105.0 o0

Experiment Name: IExampIeiExperiment

8b St:;lr:):un |
Touch each field then use the keyboard
to edit the contents. When you are finished, ?'
touch Start Run.
Notes
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Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Monitoring”
instrument. below
Standalone The computer and the instrument are “Remote Monitor” on
(Networked) connected to the same network. page 62
Standalone The computer and the instrument are not “Standalone Monitoring”
(Basic) connected. on page 64

Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the

Monitoring yellow cable, you can view the progress of the run in realtime as described below. During
the run, periodically view all three plots available from the StepOne software for
potential problems.

# To... Action

A | Stop the run 1. In the StepOne software, click STOP RUN.

2. In the Stop Run dialog, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

B | View amplification data | Select w Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 59.

C | View temperature data Select @ Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 60.

D | View progress of the Select |: Run Method.
run in the Run Method See “About the Run Method Screen” on page 61.
screen

E | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 51.

Notes
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Amplification Plot

@ Temperature Plot

Run Method
Notification Settings

} Estimated Time Remaining:56 min 22 sec Instrument Status: g Connected
Run Status 7 [ Enable Notifications E
Temperature Plot Current Temperatures
& u_ = = M cover
: .Samp\e
Temperature Plot Block
110
100
a0
80
70
2
£ 80
H
z
"E) 50
2
40
30
20
0 Temperature Plot
RBaow e meem ovam | mew o mzem e O 1 Hour 3
ime
Fixed view []

About the Ampilification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
View Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number. The figure below shows the Amplification Plot screen as it appears during the

example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in

the View Plate Layout tab.

P P Bk
Amplification Plot

ARN

2 4 B 8 MW 12 14 18 18 A0 2 4 X B N L M B B M L2 M4 &L 48
Cycle

Legend

[.0_11?11420_30

>

Selectwelis with: |- Select tem - v || |

| [37] showinwells ¥

View Legend

v,

B E

1 2 3 4 il B 7 8

T

m

o]

Sample 1 Sample 10| Sample 11/ Sample 12| Sample 13 Sample 14

e [de_m e 4 Mc_ 1 @c_1[@c_ 12 @ec_11 @ c_11

Sample 15 Sample 16 Sample 17 Sample 18 Sample 19 Sample 2 Sample 20| Sample 3

e o mec_1 e e 11\ Mc_1a [@c_+4 [@c_ 1@ c_11

Sample 4 Sample5 | Sample @ | Sample 7 | Sample® | Sample 9

e @c_1 e 1\ e\ [Mc_11 [Mc_1s Ec_BEc_n
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amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.
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» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of signal, troubleshoot the
error as explained in the StepOne Software Help (click @ or press F1).

About the Temperature Plot Screen

During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in realtime. The figure below shows
the Temperature Plot screen as it appears during the example experiment.

To...

A | Add/remove temperature plots

Action

Select Cover or Sample Block to
toggle the presence of the
associated data in the plot.

B | Change the time displayed by plot

C | Display a fixed time window during the instrument
run

If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
dropdown menu, the plot will show data for 10
minutes. If the run lasts more than 10 minutes:

e The plot updates as the run progresses with
Fixed View deselected.

¢ The plot does not update as the run progresses
with Fixed View selected.

Temperature Plot

From the View dropdown menu,
select the amount of time to display
in the plot.

Select Fixed View.

Current Temperatures

By = Gover
2 |_ = [l sample A
Temperature Plot -+ Block
110 |
e i ! ] y ! ! ¢ ; ; ! L ; H : T '
o r\
il i L
] 70
§ & ‘_J L I L} LJ [ E S B | S R S B
E’; 50
40
30 1
;
0 01:15:00 01:19:10 01:23:20 01:27:30 01:31:40 01:35:50 EI14EIEIEITi:Z|I‘1E'44'1D 01:48:20 01:52:30 01:56:40 02:00:50 02:05:00 02:08:10 View 1 Hour v B
Fixed View [] C
The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.
Notes
60 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Genotyping Experiments




Chapter 4 Run the Experiment n
Monitor the Run

* In general, the Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

» The Cover plot should maintain the constant temperature specified in the method. A
departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the
StepOne Software Help (click @ or press F1).

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

About the Run Method Screen

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run. The figure below shows the
Run Method screen as it appears in the example experiment.

To... Action

A | Change the number of cycles In the Adjust # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.

B | Add a melt curve stage to the Select Add Melt Curve Stage to End.
end of the run

C | Add a Hold stage to the end of Select Add Holding Stage to End.
the run

D | Apply your changes Click Send to Instrument.

Run Method Edit Run Method

Pre-PCR Read (Holding Stage) Holding Stage Cycling Stage B
Starting Cycle: [0 | D
100 —
75—
&0 —|
25 —|
o —
Step 1 Step 1 Step 1 Step 2
hd b
Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off ‘

If an alert appears, click the error for more information and troubleshoot the problem as
explained in the StepOne Software Help (click @ or press F1).

Notes
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Remote Monitor If your StepOne or StepOnePlus instrument is connected to a network, you can use the
Remote Monitor in the StepOne software to view the progress of the run in realtime from
any computer on the network.

IMPORTANT! Networked computers cannot control the StepOne or StepOnePlus
instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select Instrument » Remote Monitor.

2. In the navigation pane, select your instrument.

If the navigation pane does not list your instrument:
a. Click Add Instrument.

b. Enter a name for the instrument profile within the Remote Monitor.

Note: Enter any name that helps you identify the instrument. The profile name
you enter will be displayed in the Remote Monitor and in the instrument
dropdown menus when you send experiments, download experiments, or
monitor instruments.

c. In the Instrument Name, Host Name, or IP Address field:
 If you know the host name, enter the host name.

* If you do not know the host name, enter the instrument name or IP
address.

Note: The instrument name and IP address are displayed on the instrument
touchscreen. Go to Settings Menu » Admin Menu » Set Instrument Name or
Set IP Address. Contact your systems administrator or information technology
department for the host name.

d. Click Save & Exit.

Add Instrument

a Enter a name for this instrument profile within the Remote Monitor. Then, enter the instrument name, host name, or IP address to connect to the instrument. | Required
Ifyour network administrator provided you with a host name, enter the host name. Ifyou do not have a host name, enter the instrument name or IP address.  — a9 &

2b T " Profile Name
2c

*Instrument Name, Host Name, or IP Address

Save & Exit | \ Save & Add Another ‘ | Cancel

2d

Note: For more information on configuring the StepOne or StepOnePlus instrument
for network use or for the Remote Monitor feature, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

Notes
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3. Click | % | Start monitoring the instrument for your instrument. It may take
several minutes for the instrument to send the information to your computer.

1 \
File Edit Instrument Analysis Tools Help
[E2] Mew Experiment = =] Open.. =] B Close I"_—I Send Experiment to Instrument. L_|r Download Experiment from Instrument... 489 Y
Manage Instruments <«
9 & an instrument, then click "Monitor' to monitor the INEl %/ Local Simulator (Defaul) v -
% Local Instrument v [ Runstatus [ | ProfileName:  Local Simulator [[] Enable Run Natifications
Estimated Time Remaining: 75 min 5 sec Status: Connected ‘m
g ) ification Settings
2 # (Default) Local Simulator A Experiment Name: dieciipey  AlnEibiock ——
Experiment Type: Serial Number:
3 ' L5 ‘AJ |LJ ‘l”i‘ Temperature Plot
Temperature Plot Current Temperatures
110 W cover 25.0°C
- W sample 50.0°C
Block 50.0°C
80
80
o 70
5
® 60
T
g s
o
LT}
30
20
10
View Chart
0 [
00:00:00 00:01:40 00:03:20 00:05:00 00:06:40 00:08:20 00:10; Wiew 10 Minutes v |
Time Fixed View []
4. View data as described below.
# To... Action

A | View amplification data | Click Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 59.

B | View temperature data Click Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 60.

C | View progress of the Click Run Method.

run in the Run Method See “About the Run Method Screen” on page 61.
screen
D | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 51.

Notes
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File Edit Instrument Analysis Tools Help

[E] New Experiment ~ [55 Open.. [

_1 Close ’IJ_‘| Send Experiment to Instrument... ’—T’L Download Experiment from Instrument... .@

Manage Instruments «

Add Instrument...

ment, then click "Monitor” to monitor the instrument.  KE SETEIRIRITE T (REEITTES -

[ Run status:
Estimated Time Remaining: 75 min 5 sec
Experiment Mame
Experiment Type:

'Qf Local Instrument

& (Default) Local Simulator

Profile Name:  Local Simulatar
Status:

Block Type:
Serial Number:

[]Enable Run Motifications

48-Well Block G Netficaton Settings |

‘LJ |£J ‘LJ |2‘ ‘hl Temperature Plot
| |
T 1 T Temperature Plot Current Temperatures
/A\‘ ....... /B\ ..... /C\‘ .................................................... W Cover 250°C
\Tn/u/ ~ e Wsampls 500°C
Block 50.0°C

Standalone If you started the run from your StepOne or StepOnePlus instrument, you can view the
Monitoring progress of the run from the touchscreen. The Run Method screen displays the method
for the experiment and highlights the thermal profile steps as the instrument performs
them.
# To... Action
A | Add a melt curve stage | Touch i{|-A. Add Melt Curve, then touch OK.
to the run
B | Display the time Touch Display Experiment Time, then touch X to return
remaining in the run to the Run Method screen.
C | Stoptherun Touch [ STOP, then touch:
e Stop to stop the run after the instrument completes the
current cycle or hold.
¢ Abort to stop the run immediately.
e X to continue the run with no changes.
D | View experiment Touch View Experiment Information, then touch X to
information return to the Run Method screen.
E | View the Error Log Touch the status bar to display the error log.
( 64.8°C 00:53:42
Experiment: Example_Experiment
steze 1 B Stege 3 Stage 4
X1 ¥ 40 Hl
a a a
95.0" 1 95.0°
60.0° 1/ 103001 OHIS N g 071 go.0”
0:30 1:00 0:30
D ‘ K B
Al | 3 o ] c
Add Melt Curve View Experiment Display Experiment STOP
Information Time

Notes
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Unload the Instrument and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload
the reaction plate from the instrument and transfer the experiment data to the computer
for analysis.

Unload the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the
sample block(s) reach room temperature.

Note: When the StepOne or StepOnePlus instrument completes a run, the system saves
the details of the run to the run history, which remains present in the system until the
instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument
touchscreen, touch (#).
2. Open the instrument drawer.

3. Remove the reaction plate from the sample block(s).

4. Carefully close the instrument drawer.

A CAUTION

Select a Data Transfer the experiment to your computer for analysis according to the layout of your
Transfer Method  StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer and “Colocated Data Transfer”
the instrument. below
Standalone The computer and the instrument are “Remote Data Transfer” on
(Networked) connected to the same network. page 66
Standalone The computer and the instrument are not “Standalone
(Basic) connected. Data Transfer” on page 67
Notes
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Colocated
Data Transfer

Remote
Data Transfer

Notes

66

If your computer is directly connected to your StepOne or StepOnePlus instrument by the
yellow cable, no action is necessary. The StepOne software automatically transfers the
experiment data from the instrument to the computer after the run.

Note: In a colocated layout, you can start the run from the computer or from the
instrument touchscreen. However, the StepOne software only transfers the experiment
data automatically when a run is started from the computer (see “Colocated Startup” on
page 54).

If your computer and StepOne or StepOnePlus instrument are connected to the same
Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click &, Download Experiment from Instrument to
open the Download Experiment from Instrument dialog box.

2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.

4. In the Download File To field:
a. Click Browse.

b. Navigate to:
<drive>:\Applied Biosystems\<software name>\experiments\
where:

<drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

c. Click Select.

5. Click Download Experiment to download the example experiment file from your
instrument to your computer over the network.

Download Experiment from Instrument

n Selectthe instrument with the sxperiment, select a location on this computsr for the experiment, )
then click "Download Experiment.” i

2 I - 1. 8elect Instrument: Q Local Instrument (Default) v | Experiment 3
4 | - 2. Download File To: | Cl\Applied Biosystems\StepOne Software v2.0\experiments | Browse...
5 | | Cancel ‘

6. When prompted, click OK to close the confirmation.

Download Complete
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Standalone If your computer is not connected to your StepOne or StepOnePlus instrument, use the
Data Transfer USB drive to transfer the experiment from the instrument to the computer:

1. Ifnot already connected to the instrument, connect a USB drive to the USB port.

I

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

3. Wait for the USB sign to appear on the touchscreen.

4. Inthe Main Menu, touch Collect Results to save the data to the USB drive.
Note: If your instrument cannot find the USB drive, remove the USB drive, then try

again. If the instrument still does not recognize the USB drive, try another USB
drive.

5. When prompted that the data has been transferred successfully, touch OK.
i‘;;)\?riem]el\;i:' l Settings Menul Tools Menu l Ig:sltzl‘é: l

& Information
RiaseP Wi RESTISLY

Experiment results reacy:
You may remave your USE storage

Shorteu Shorteut
5 oK I 8
@ 2006-11-18 | 2:15 PM '*
<

6. Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.

Notes
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8. Copy the example experiment file to:
<drive>:\Applied Biosystems\<software name>\experiments\

where:

» <drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

Notes
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E Analyze the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 70
B Open the Experiment for the Analysis . ............ .. ... .. ... .. ... .. .... 71
B View the Allelic Discrimination Plot .. ...... ... ... ... ... .. ... ........ 73
B Viewthe Plate Layout. .. ...t e 76
B Viewthe Well Table . . ... ... 78
B View the QC Summary. . ...ttt 81
B Viewthe Raw DataPlot .. ... ... ... . 82
B View the Multicomponent Plot. . ....... .. ... .. .. ... .. .. ... .. ... ... ... 84
B View the Amplification Plot. ... ... ... .. .. .. . 86
B View the Analysis Settings . . ... ..ottt 93
B PublishtheData .. ... ... . 98

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to view, analyze, and publish the analyzed experiment.

Workflow Start Experiment

v
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

View the allelic discrimination plot.
View the plate layout.

View the results in a table.

View the quality summary.

View the raw data plot.

View the multicomponent plot.
View the amplification plot.

View the analysis settings.

Publish the data.

© ©® N o kDN~

v

End Experiment

How to Evaluate Review of the results occurs in three steps:

the Results o _ S

1. Perform an initial review of the Allelic Discrimination Plot (see page 73), the plate
layout (see page 76), and the well table (see page 78) to evaluate the genotype calls
made by the StepOne software.

2. Perform a thorough review of the QC Summary (see page 81) to evaluate the
samples that triggered QC flags. Review the raw data (see page 82) and
amplification data (see page 86) for the samples that exhibit abnormal
amplification.

3. If necessary, define the analysis settings (see page 93) or modify the calls manually
(see page 97).

After evaluating the results, you can publish the results as explained in “Publish the Data”
on page 98.

Notes
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Open the Experiment for the Analysis
Prepare for the analysis by opening the experiment.

About the For the genotyping example experiment, use the data file that installs with the StepOne
Example software. The data file was created with the same design parameters provided in
Experiment  Chapter 2, then run and analyzed on a StepOne™ instrument.

You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Genotyping Example.eds
where:

* <drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

—h

Open the . Double-click g (StepOne software) or select Start » All Programs » Applied
Experiment Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when you designed the
genotyping experiment (page 17).
3. From the Home screen, click Open.

4. In the Open dialog box, navigate to the examples folder:

<drive>:\Applied Biosystems\<software name>\experiments\examples

5. Double-click Genotyping Example to open the example experiment data file.
Note: The examples folder contains several data files; be sure to select Genotyping

Example. For information on the other data files, see “Data Files in the Examples
Folder” on page 12.

Notes
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3 MW Esperms— BF Open.. H [ "J\_“ Send Experiment to Instrument Lf:, Download Experiment from Instrument.. 48

Analyze

ﬁ‘ e Experiment

4 i ) examples 3 ﬁl”j‘@'é

i] 96-Well Genotyping Example.eds
i] 96-Well Multiplex Example.eds
My Recent 1) 96-Well Presence Absence Example eds
_ Documents | |4) 96-Well RNaseP Experiment eds
|#] 96-Well Standard Curve Example.eds
3] 96-Well SYER Example eds
i] Comparative CT Example.eds
5 — i] Genotyping Example.eds
i] Multiplex Example.eds
%] Presence Absence Example.eds
|#] Relative Standard Curve Example eds
|#] RNase P Experiment eds
|#] Standard Curve Example eds
i] SYBR Example.eds

My Computer

“
File name

My Network
Places Files oftype: Al SDS Files (edm; eds; edt)

* Home

For More For more information, access the StepOne Software Help by clicking @) or pressing F1.
Information

Notes
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View the Allelic Discrimination Plot

Perform an initial review of the experiment results in the Allelic Discrimination Plot,
which contrasts the normalized reporter dye fluorescence (R,) for the allele-specific
probes of the SNP assay. See “Reading and Analyzing the Plates” on page 8 for a
complete description of the plot.

About the For the example experiment, confirm that the Allelic Discrimination Plot displays:

Example Data * Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2
homozygous, and Allele 1/2 heterozygous)

* A cluster for the negative controls

Review the Plot 1. From the Experiment Menu pane, select Analysis » [ Allelic Discrimination
Plot.

Note: If no data are displayed, click Analyze.

2. Click the View Plate Layout tab, then click any empty well to select it.

Note: In the Allelic Discrimination Plot, the software highlights all wells that are
selected in the View Plate Layout tab. If the plot displays a single color for all wells,
then all wells in the plate layout are selected.

3. In the amplification plot, select C__11711420_30 from the SNP Assay menu.

» Ifthe Autocaller is enabled, the Allelic Discrimination Plot displays allele
symbols for each sample evaluated for the selected SNP.

The samples are grouped on the plot as follows:

Symbol Are grouped along the... The genotypes of the samples are...

® (red) X-axis of the plot Homozygous for Allele 1 of the selected
SNP assay.

@ (blue) Y-axis of the plot Homozygous for Allele 2 of the selected
SNP assay.

(green) | Midway between the Heterozygous for both alleles of the
homozygote clusters selected SNP assay (Allele 1 and Allele 2).
B (black) | Bottom-left corner of the plot | A negative control.
X (black) | Anywhere on plot Undetermined.

» Ifthe Autocaller is not enabled, the Allelic Discrimination Plot displays a
crossmark (X — Undetermined) for each sample.

4. For each cluster in the plot:

a. Click and drag a box around the cluster to select the associated wells in the
plate layout and well table.

Notes
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b. Confirm that the expected wells are selected in the well table.

For example, if you select the cluster at the bottom-left corner of the plot, only
the negative controls should be selected. The presence of an unknown among
the negative controls may indicate that the sample failed to amplify.

c. Repeat steps 4a and 4b for all other clusters in the plot.

Element

Description

SNP Assay
dropdown menu

Determines the SNP assay data that the StepOne software
displays in the plot.

Plot Type
dropdown menu

Apply Call
dropdown menu

Toolbar

Legend

Determines the type of plot (Cartesian or Polar) that the StepOne
software will use to display the data.

When a datapoint is selected, this menu allows you to assign an
allele call to the datapoint within the scatterplot.

Contains tools for manipulating the scatterplot:

° IEJ — Selects datapoints by clicking individual datapoints, or
by clicking and dragging a box around a group of datapoints.

o |E] — Selects datapoints by encircling them.

o |:§ij — Repositions the scatterplot.

o |- Magnifies the scatterplot.

o W - Zooms out the scatterplot.

An explanation of the symbols in the scatterplot.

The figure below shows the Allelic Discrimination Plot of the example experiment.

Plot Settings
3 NP Assay: |C__11711420_30 » Apply Call
Plot Type Cantesian «
(S R a i g =
Allelic Discrimination Plot
25 }
20
15
k=)
10
0.5 ‘
o g®
4a m
CRl 03 05 o7 0o
A
Legend
oA *CiC
L X Undetermined

>

SelectWells With:

B view Legend

- Selecttem - »

+,
|

1z 3 | 4 [ s [ & [ 7 [ 8 |

EE

| [@ 7 showinwells ¥

4b

S\\mr\ln'l Samnia 11 |Samnla 11 Samnls 12 Samnla 13 | Samnls 14

Lo Dc—“yjc_n M |Mec_s [Me_11|[@c_1 [Mc_1

=

Samplgi5—Sample 16 Sample 17| Sample 12 |Sample 19 Sample2 |Sample 20| Sample 3

e s e |[@ec_11|[@c_11 e [@e_11 [@c_1|@c_1

m@

Sample 4 Sample5  Sample@  Sample 7 | Sample 8  Sample@

¢ e+ et |[@c_11|c_11|[ec_11 [@ec_11 B e

wells: [ 20 Unknown [ 2 Negative Control ] 2 Positive Contral 24 Empty

Notes
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Analysis When you analyze your own experiment:
Guidelines * Confirm that all controls have the correct genotype.
 [f using positive controls, confirm the calls for the positive controls:

a. From the well table, select the wells containing a positive control to highlight
the corresponding datapoints in the Allelic Discrimination Plot.

b. Check that the datapoints for the positive controls cluster along the expected
axis of the plot. For example, if you select the Positive Control
Allele 1/Allele 1, then the controls should cluster along the X-axis.
c. Repeat steps a and b for the wells containing the other positive controls.
» Screen the negative control cluster for unknown samples that failed to amplify:

a. Select the datapoints of the cluster in the lower left corner of the Allelic
Discrimination Plot to select the corresponding wells in the well table.

b. Check that the selected wells in the well table are negative controls, and not
unknown samples.
» Samples that clustered with the negative controls may:
— Contain no DNA
— Contain PCR inhibitors
— Be homozygous for a sequence deletion

* Confirm the results of the samples that did not cluster tightly or are clustered with
negative controls by retesting them.

» If you select to run replicate reactions, carefully review your data set for outliers to
ensure the accuracy of the genotype calls. If outliers are present, confirm the results
of the associated samples by retesting them.

* Observe the number of clusters in the plot. If the Allelic Discrimination Plot
contains less than the three representative genotype clusters (heterozygous,
homozygous allele 1, and homozygous allele 2), then the StepOne software may not
be able to genotype the samples until you enable the 2-Cluster Calling feature.

If the plot contains less than three clusters:
a. Click Analysis Settings.
b. Click Edit Default SNP Assay Settings.
Select 2-Cluster Calling Enabled, then click Save Changes.

o

d. Click Apply Analysis Settings.

e. Click Reanalyze to reanalyze the experiment using 2-Cluster Calling.

Note: The results displays are synchronized. For example, selecting a well in the plate
layout selects the corresponding data in the well table and Allelic Discrimination Plot.

For More For more information on the Allelic Discrimination Plot, access the StepOne Software
Information  Help by clicking g) or pressing F1.

Notes
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View the Plate Layout

Review the experiment results in the plate layout. The plate layout displays the assay-
specific setup and analysis properties for the experiment in a well format corresponding
to the type of reaction plate used for the run.

About the
Example Data

For the example experiment, confirm that the StepOne software called:
* 6 samples as Allele 1 homozygous (®)
* 4 samples as Allele 2 homozygous (@)
* 12 samples as heterozygous (@)
» 2 samples as negative controls (H)

Confirm that no wells of the reaction plate triggered QC flags (4A).

View the Layout 1. Click the < icon beside the Allelic Discrimination Plot to maximize the plate layout.

2. Click [@]] Show in Wells, then select or deselect a parameter that you want the wells
to display.

3. Repeat step 2 until the plate layout contains all of the desired parameters.

Task The task assigned to the well:
e [0 - Unknown
e [ - Negative Control
e [& - Positive Control
SNP Assay Name | The name of the SNP evaluated by the well.
Assay ID The Assay ID number of the SNP evaluated by the well.
Allele 1/ Allele 2 The name of the associated allele for the SNP evaluated by the well
Allele 1 Dyes / The name of the reporter and quencher dyes of the associated allele for
Allele 2 Dyes the SNP evaluated by the well
SNP Assay Color | The color of the SNP evaluated by the well.
Sample Color / The color of the sample or task applied to the well.
Task Color
Genotype Call The allele call assigned to the sample:
e ® Homozygous 1/1
¢ @ Homozygous 2/2
o Heterozygous 1/2
¢ M Negative Control
e X Undetermined
Flag The number of QC flags the well triggered as listed in the A symbol.
Notes
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The following figure shows the plate layout of the example genotyping experiment.

1 [View Plate Layout | View Well Table |
SelectWells with: - Selectitem - v |
2 w ViEW Jeeene | |
. Sample Name |
2 3 4 5 [} 7 8
Task
SNP Assay Name Sample 1 Sample 10 Sample 11 Sample 12 Sample 13 Sample 14
Assay ID etz W [ c_11711az0_. @ [0 c__11711az0_... @ [ c_11711az0_.. @ [0 c_14711420_.. @ [ c_11711420_... @ [ c__11711420_. @
Allels 1
Allele 2 Sample 18 Sample 17 Sample 18 Sample 10 Sample 2 Sample 20 Sample 3
3 Blele 1 Dyes c_111azo_. @ [0 c_117114z0_. @ [ c_11711azo_ @ [ c_11711az20_ @ [ c_19719az0_ @ [ c_117114z0_. @ [ c_117114z0_. @

Allele 2 Dyes
SNP Assay Color Sample 5 Sample & Sample 7 Sample 8 Sample @

c_11711az0_ @ m c_11711a20__ @ c__117114z0_ @ c_11711az0_ @ m c_11711a20_ . @ Bl c_1mitazo_.. @ E c_117114z0_. @

Sample Color

Task Color
Genotype Call
’Z Flags

E

F

Wells: [l 20 Unknown [Z] 2 Megative Control [f] 2 Positive Control 24 Empty

Analysis When you analyze your own experiment:

Guidelines * The plate layout displays E in the top-left corner of wells omitted by the user; it
displays D in the corner of wells omitted by the QC flag settings.

* Note the location of any samples that trigger QC flags (A ). Understanding the
position of errors can aid in diagnosing any failures that may occur.

* You can select the entire reaction plate, areas of the reaction plate, or specific wells:
— Click the upper left corner of the reaction plate to select all 48 wells.
— Left-click the mouse and drag across the area to select it.

— Select Sample, Target, or Task from the Select Items menu in the View Plate tab.
Then select the sample, target, or task name from the second Select Items menu
to select wells of a specific type using the well-selection tool.

* You can adjust the plate layout:

— Use the (Zoom In), (Zoom Out), and (Fit All) buttons to increase or
decrease the wells shown.

— Use the arrow tabs to expand the plate layout to cover the entire screen.

For More For more information on the plate layout, access the StepOne Software Help by
Information clicking @) or pressing F1.

Notes
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View the Well Table

Review the details of the experiment results in the well table and identify any flagged
wells. The well table displays the assay-specific setup and analysis properties for the
experiment in a table format.

About the For the example experiment, confirm that no wells of the reaction plate triggered
Example Data QC flags (4).

Review the Table 1. Select the View Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.

3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ( 4. ).

c. Click the —icons to collapse the negative and positive controls.

4. Click > beside the View Well Table tab to display the Allelic Discrimination Plot
and the well table simultaneously.

The figure below shows the well table of the example genotyping experiment.

1 \
View Plate Layout | View Well Table ]
SelectWells With: |- Selectitem -
3a . :
[ show nTasie = | eroupsy v | ‘ Y sxpana | B colrapse anl |
2
# | Well _Om\t Flalg Sample Na SNP Assay.. AssaylD Task Allele 1 Allele 2 Allele 1 .. Allele 2 .. Allelz 14 Allele 24
30 — 1 & Negative Control 2
1 Al C__11711420... MNegative Cont... A 4 VIC-NFQ-M... FAM-NFQ-...
2 A2 O C__11711420... Negative Cont... A c VIC-NFQ-M... FAM-NFQ-...
30 . I = Positive Coﬂtwl‘ Allele 1/|allele 2
3 cv { C__11711420... Positive Contr... A c VIC-NFQ-M... FAM-NFQ-...
30 N Positive Control\Allele 2JAllele 2
4 ce 0O C__11711420... Positive Contr... A c VIC-NFQ-M... FAM-NFQ-...
= Unknown
3b 5 A3 1 Sample 1 C__11711420... Unknown A c VIC-NFQ-M... FAM-NFQ-...
[ Ad [ Sample 10 C 11711420, Unknown A c VIC-NFQ-M... FAM-NFQ-...
Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been removed from the analysis.
Flag A 1 indicates that the well triggered the number of flags listed inside the symbol.
Sample Name The name of the sample.
SNP Assay Name The name of the SNP assay evaluated by the well.
Assay ID The Assay ID number of the SNP evaluated by the well.
Notes
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Column Description
Task The task assigned to the well (Unknown, Negative Control, or Positive Control).
Allele 1/2 | The name of the associated allele for the SNP evaluated by the well.
Allele 1 /2 Dyes | The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well.
Allele 1 /2R, Normalized signal (R,) of the reporter dye of the associated allele for the SNP evaluated by the well.
Pass Ref The signal of the passive reference dye for the well.
Call The allele call assigned to the sample, where possible calls are:

e @ Homozygous 1/1 - Homozygous for allele 1
¢ @ Homozygous 2/2 - Homozygous for allele 2
o Heterozygous 1/2 - Heterozygous

¢ M Negative Control

e X Undetermined

Quality(%) | The quality value calculated for the genotype call.

Method | The method used to assign the call to the sample (Auto if assigned by the StepOne software, or Manual
if applied by a user).

Comments Comments entered for the associated sample well.

Allele 1/2 Cy | Threshold cycle (Cq) of the sample for the associated allele for the SNP evaluated by the well.

QC Flag Columns

The well table displays columns for QC flags that are triggered by the experimental data. If the experiment data does not trigger a
QC flag, then the StepOne software does not display a corresponding column for the flag.

A A in one of the following columns indicates that the associated well triggered the flag.

BADROX The well produced a passive reference signal greater than the limit defined in the analysis settings.

OFFSCALE The well produced a level of fluorescence greater than the StepOne or StepOnePlus system can
measure.

NOSIGNAL The well did not produce a detectable level of fluorescence.

CLUSTER# For the SNP evaluated by the well, the number of clusters generated from the experiment data is greater
than the limit defined in the analysis settings.

PCFAIL The positive control did not produce an R, for the associated allele greater than the limit defined in the
analysis settings indicating that the control may have failed to amplify.

SMCLUSTER The number of data points in the associated cluster is less than the limit defined in the analysis settings.

AMPNC The negative control has produced a R, greater than the limit defined in the analysis settings indicating

possible amplification.

NOAMP The well did not produce an R, for either allele that is greater than the limit defined in the analysis
settings indicating that the well may have failed to amplify.

NOISE The background fluorescence (noise) produced by the well is greater than the other wells on the
reaction plate by a factor greater than the limit defined in the analysis settings.

SPIKE The amplification plot for the well contains one or more data points inconsistent with the other
points in the plot.

Notes
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Column
EXPFAIL
BLFAIL
THOLDFAIL

Description
The software cannot identify the exponential region of the amplification plot for the well.
The software cannot calculate the best fit baseline for the data for the well.

The software cannot calculate a threshold for the associated well.

CTFAIL

The software cannot calculate a threshold cycle (C;) for the associated well.

Analysis
Guidelines

For More
Information

Notes
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When you analyze your own experiment:

» If you are using positive controls, also confirm the integrity of the positive controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate

b. Confirm that the positive controls do not display flags (A) and that their
normalized reporter dye fluorescence (R,) is appropriate for the genotype
(for example, if evaluating the Positive Control Allele 1/Allele 1, you would
expect to see significant increase in R, for the Allele 1 probe and very little for
the Allele 2 probe).

c. Repeat step b for the each positive control.

* Review the data for the Unknown samples. For each row that displays A in the Flag
column, note the data and the flag(s) triggered by the associated well.

* Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an area of
the table.

— Selecting Sample, Target, or Task from the Select Items menu in the View Table
tab, then selecting the sample, target, or task name from the second Select Items
menu to select wells of a specific type using the well-selection tool.

* Group the rows of the plate layout by selecting an option from the Group By menu.
You can then collapse or expand the lists either by clicking the +/- icon next to
individual lists, or by clicking Collapse All or Expand All.

* Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

For more information on the well table, access the StepOne Software Help by
clicking ) or pressing F1.
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View the QC Summary

Review the summary of the QC flags triggered by the experiment data and troubleshoot
the flags. The QC summary displays a frequency and location of all QC flags. If a flag
does not appear in the experiment, its frequency is 0. If the frequency is not 0, that flag
appears at the well position listed in the location column. Clicking a flag displays the flag
details, including a list of all flagged wells.

About the In the genotyping example experiment, you review the QC Summary screen for any flags
Example Data triggered by the experiment data. In the example experiment, no flags have been
triggered.

Review the 1. In the navigation column, select % QC Summary.

Summary _ _
2. Review the Flag Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment, the Frequency
column displays 0 for all flags.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.

QC Summary

Flag v
Total Wells 48 | Processed Wells. 24 | SNP Assays Used, 1
Wells Set Up 24 | Flagged Wells 0 Samples Used 20
' 2
Flag Details
Flag Name Frequency Wells

4 BADROX Bad passive reference signal 1] ~
OFFSCALE Fluorescence is offscale [i
NOSIGMAL Mo signal in well 0
CLUSTER# Mumber of clusters outside expected range 1]
PCFAIL FPositive control failed 0
SMCLUSTER Small number of samples in cluster [i
AMPHC \Amplification in negative control 0
MNOAMP Mo amplification 1]
NOISE Noise higher than others in plate [i
SPIKE Moise spikes 0 |

Flag: BADROX—Bad passive reference signal
Flag Detail: Passive reference signal is abnormal
Flag Criteria: Fluorescence < 500.0
Flagged Wells: None
View BADROX Traoubleshoating
Infarmation
Notes
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Analysis When you analyze your own experiment:

Guidelines * Select each QC flag in the Flag Details with a frequency greater than 0, review the

frequency and location of the wells that triggered the QC flag, then click the link for
troubleshooting the flag.

Note: When you select a flag in the Flag Details table, the well table highlights the
wells that triggered the flag.

For More For more information on the QC Flags, access the StepOne Software Help by
Information clicking g) or pressing F1.

View the Raw Data Plot

If necessary, review the Raw Data Plot for irregularities in the raw spectra collected by
the StepOne™ or StepOnePlus™ instrument.

The Raw Data Plot displays the amplitude of the raw fluorescence collected in each
channel (1 through 3) during the run cycle indicated by the Show Cycle slider. The plot
displays the raw spectra for the wells selected in the plate layout or the well table.

About the In the example experiment, review the Raw Data Plot screen for a stable increase in
Example Data signal (no abrupt changes or dips) from the appropriate filter.

Review the Plot 1. In the navigation pane, select % Raw Data Plot.
2. 1In the well table, select the wells that you want to inspect.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate.

Notes
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4. Drag the Show Cycle slider to view temporal changes in each filter of the raw data
profile. The filters are:

StepOne system StepOnePlus system

Filter Dye Filter Dye
1 FAM™ dye 1 FAM™ dye
SYBR® Green dye SYBR® Green dye
2 | JOE™ dye | | 2 | JOE™ dye
| VIC® dye | | VIC® dye
3 | ROX™dye 3 TAMRA"dye
NED™ dye

4 ROX™ dye

The figure below shows raw data from the example genotyping experiment.

3 ] >
R Selectwelis with: |- select tem - || |
B =
Raw Data Plot | [0 snowinwens v | [ view Legend ‘ |
70.000
67.500 1 2 3 4 5 G 7 ]
65.000 Sample 1 Sample 10 Sample 11 Sample 12 Sample 13 Sample 14
62,500 A et/ e Mc_iMc_ 11 @Mc_1ic_1/ e/ [Mc_11
60,000
2 P 57.500 _ |sample 15 Sample 18 Sample 17/ Sample 18/ Sample 19 Sample 2 Sample 20, Sample 3
2 55,000 =
H Me iMe i @c 1 e 1i[ec_1@c_1mi@c_1iec_ 11
£ 52500
50.000 o Sample 4| Sample 5 Sample®  Sample 7 | Sample 8 Sample 8
47,500 M Mec_1 M c_1 M c_11i M c_11 Mc_11 P LEER) > LERY
45,000 ——
42500 e
40,000 o
1 2 3
Fitter
Legend =
{-A o c o MN:INF
Options ! F
ShowCycle 20 - {
¢ (0 2l gl e By Wells m 20 Unknown D 2 Megative Control E 2 Positive Control 24 Empty

Analysis When you analyze your own experiment, look for the following in each filter:
Guidelines * Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot, access the StepOne Software Help by
Information clicking @) or pressing F1.

Notes
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View the Multicomponent Plot

The Multicomponent Plot displays the complete spectral contribution of each dye in a
selected well over the duration of the PCR run.

About the In the example experiment, review the Multicomponent Plot for:
Example Data « ROX"™ dye (passive reference)
+ FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
+ Amplification in the negative control wells

View the 1. In the navigation column, select | Multicomponent Plot.

Multicomponent _ _ . .
Plot 2. Select one unknown well in the plate layout to display the corresponding data in the

Multicomponent Plot.

Note: Ifyou select multiple wells, the Multicomponent Plot screen displays the data
for all selected wells simultaneously.
3. From the Plot Color dropdown menu, select Dye.

4. Click i= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the FAM™ and VIC® dye signals. In the example experiment, the FAM™ and
VIC® dye signals increase throughout the PCR, indicating normal amplification.

6. Check the ROX® dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process, which indicates typical data.

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Notes
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Analysis When you analyze your own experiment, look for:
Guidelines » Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

» Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

For More For more information on the Multicomponent Plot, access the StepOne Software Help by
Information  clicking @) or pressing F1.
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View the Amplification Plot

If you collected real-time data for your experiment, review the amplification data to
further understand the flags triggered by the experiment data.

The Amplification Plot screen displays amplification of all samples in the selected wells.
Use the amplification plots to confirm the results of the experiment:

* ARn vs Cycle — ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot displays
AR, as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* C;vs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cy as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.
Note: For more information about the Amplification Plots, refer to the Applied

Biosystems StepOne"" and StepOnePlus™ Real-Time PCR Systems Reagent Guide or the
StepOne Software Help.

About the In the example experiment, review the Amplification Plot for:

Example Data e Correct baseline and threshold values

e Qutliers

Review the 1. In the navigation column, select |_// Amplification Plot.

Results
2. In the Amplification Plot:

a. From the Plot Type dropdown menu, select ARn vs Cycle.
b. From the Plot Color dropdown menu, select Allele.

c. Click §= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

3. View the baseline values:
a. From the Graph Type dropdown menu, select Linear.

b. Select Baseline to show the start cycle and end cycle.

Notes
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c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is detected.
In the example experiment, the baseline is set correctly.

2a 3a 2b

Plot i
| | |
Plot Type:[aRnvs Cycle | Graph Type:|Lingar | Plot Color:|alisle - ‘

A E a g E T 2c

Amplification Plot

225
2.00
1.75
1.50

= 1.25
% 1.00
078
050
025

000 { EE—=E—

Legend
[. C_11711420_30-A [l c__11711420_30-C

Options

Targst: Thrashold: 1
Show: [] Threshold — [#] Baseline Start Well B Target 4 Baseline End: Well B Target 4=
3b ‘
4. View the threshold values:
a. From the Graph Type dropdown menu, select Log.
b. From the Target dropdown menu, select C__11711420_30-A.
c. Select Threshold to show the threshold.
d. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.
e. Repeat steps 4a through 4d for C__11711420_30-C.
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4a
Plot i
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5. Locate any outliers:
a. From the Plot Type dropdown menu, select Cy vs Well.

b. Confirm that the replicate wells have achieved similar amplification. The
example experiment does not use replicate wells.

Analysis When you analyze your own experiment, look for:
Guidelines

Outliers

* A typical amplification plot — The StepOne software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a typical
amplification plot. A typical amplification plot has four distinct sections:

a

b

(9

o

. Plateau phase
. Linear phase
. Exponential (geometric phase)

. Baseline

Notes
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0.210658
a1 [Threshold

ARnNn

0.01

0.001

~ o I
A - el
I'I i ,'II‘II:I(". [ ; il |I‘\’y I',

0.0001
a

T )
aa1012|1¢1ﬁ1amwxoaﬂ“?)t“\ama

Cycle

d

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the StepOne software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis completes.
For more information, see the StepOne™" Sofiware Help.

» Correct baseline and threshold values — See the threshold examples on page 90 and
the baseline examples on page 91.

Notes
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Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve. 1

Threshold settings above or below the optimum v21219
increase the standard deviation of the replicate 013
groups. s

o001

Threshold Set Too Low

The threshold is set below the exponential phase of
the amplification curve. The standard deviation is "
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up
into the exponential phase of the curve.

FL\i/
0.0001 . o

Threshold Set Too High

The threshold is set above the exponential phase of
the amplification curve. The standard deviation is i
significantly higher than that for a plot where the !
threshold is set correctly. Drag the threshold bar
down into the exponential phase of the curve.

L.754743

ARn

| \
00001
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Baseline Set Correctly
The amplification curve begins after the maximum 4
baseline. 7/
;' 100 "4
] ,/

Baseline Set Too Low

The amplification curve begins too far to the right
of the maximum baseline. Increase the End Cycle .
value. i

N

Baseline Set Too High

The amplification curve begins before the Y,
maximum baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Manually adjust the baseline and/or threshold (see the StepOne Software Help).
or
* Omit a well by right-clicking the well in the plate layout and selecting Omit.

Notes
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N

Notes

92

View the Amplification Plot

How to View Multiple Plots Simultaneously

The multiple plot view displays up to four plots for simultaneous analysis. You can view
each plot individually, two plots as rows or columns, or all plots in a 2 X 2 matrix.

To review the results in multiple plots:

1. In the navigation column, select [2% Multiple Plots View.
2. Click = to display two plots in parallel.
3. In the top plot, select Amplification Plot (AR, vs. Cycle) to view results of the
amplification run for each well selected in the plate layout.
4. In the bottom plot, select Raw Data Plot to view the raw data for each well selected
in the plate layout.
Multiple Plots View <| View Plate LayoutT View well Table ]
a5 ill ? SelectWells With |- Select tem - v || |
|Ampl'rﬁ[:a1iunPln1-AansCy[:IE ‘If| | ElsnowinWellsv ViewLegend ‘ |
. /® /9 \L g T_ 1 2 3 4 [} B 7 8
. ;:‘ A e e e e e e e

Sample 15 Sample 16 Sample 17 Sample 18, Sample 19 Sample 2 Sample 20/ Sample 3

Mc e i @c_ 1 [Mc_vic_1Mc_mi@c_1ic_1

m

Cyecle

Legend
{. ©_ 11711420_30
o | Sample 4| Sample | Sampies ' Sample7 | Samples | Sample
! e iMec 1 @c 1 [c_1iec_11 [Mc_11 P LEER) > LAY
[Raw Data Piot v

{ Legend

A

slc o lN:INF

Wells 20 Unknown [1] 2 Negative Control [l 2 Positive Control 24 Empty

For More For more information on the Amplification Plot or on the Multiple Plot View, access the
Information  StepOne Software Help by clicking g) or pressing F1.
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View the Analysis Settings

If you are dissatisfied with how the StepOne software is calling genotypes or the
thresholds of the QC flags, review and adjust the analysis settings and/or calls as needed.

About the In the example experiment, review and adjust the analysis settings as desired to learn how
Example Data the call, C, and flag settings contribute to the analysis of the genotyping data.

Modify the 1. In the experiment, click Analysis Settings.

Analysis Settings . )
2. Adjust the call settings:

a. Select the Call Settings tab.
b. Select the C__11711420_30 from the Select a SNP Assay table.
Click Edit Default Settings.

o

d. If you have made manual calls, select Keep Manual Calls from Previous
Analysis in the Edit Default Call Settings dialog box.

e. In the Quality Value field, enter a percentage value to apply as the quality
interval for autocalling samples. The greater the value, the more stringent the
allele calling.

f. Click Save Changes to save your settings.

Call §ettingsT Ct Settings T Flag Settings T Advanced Settings ]

a Review the default settings for analysis of the SNP assays in this experiment. To edit the default settings, click "Edit Default Settings." To use different settings for a
SMNP assay, selectthe SNP assay from the table, deselectthe "Use Default Settings” checkbox, then change the seftinas that are displayed.

Data Analysis Settings
() Analyze Data from Post-PCR Read Only  (3) Analyze Data fram Pre-PCR Read and Post-PCR Read

& Edit Default Call Settings

Default Call Settings

Default call settings are used to make allele calls fo| Editthe default call settings, then click"Save ttings, click "Edit Default Settings "
Changes." Editing the default call settings does not
Autocaller Enabled: Mo Keep Manual Calls from | 8Mectwells with custom seftings. INEINCRT R Ecit Defaut Setings 2c

[¥] Autocaller Enabled
—y— [¥] Keep Manual Calls from Previous Analysis Call Settings for C__11711420_30
[[] 2-Cluster Calling Enabled

- IE
| save Changes | cancel

Select a SNP Assay

SNP Assay Analysis Type Autop=tar
2b C_11711420_3C‘|Default |Yes _

Apply Call Seftinas: Use Default Settings

@
3. Adjust the C; settings:
a. Select the C Settings tab.
b. Select allele A from the Select an Allele table
c. Deselect Use Default Settings
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 93

Genotyping Experiments



n Chapter 5 Analyze the Experiment
View the Analysis Settings

d. Deselect Automatic Threshold, then enter a new threshold value.
e. Deselect Automatic Baseline, then enter new baseline values.

f. Repeat steps 3b through 3e for allele C.

Note: For more information on setting the threshold cycles for genotyping runs, see
the StepOne Software Help.

E-A Analysis Settings for Genotyping Example

Call Seftings | Cr SeﬂingsT Flag Settings I Advanced Settings ]

a Review the default settings to calculate the Ctforthe alleles in this experiment. To edit the default settings, click "Edit Default Settings.” To use different settings for an
allele, selectthe allele from the table, deselectthe "Use Default Settings" checkbox, then change the settings that are displayed.

Default Cr Settings
Default CT seftings are used to calculate Ctfor alleles without custom settings. To editthe default settings, click "Edit Default Settings.”

Threshold: AUTO Baseline Start Cycle: AUTO  Baseline End Cycle: AUTO | Edit Default Seftings ‘

Select an Allele C1 Settings for C__11711420_30, A
SNP Assay Allele Threshald Baseline Start Baseline End T Settings to Use: [ Use Default Settings 30
~
3b C_ 1171142030 |A 0.037759 3 15 ] Automatic Threshald 3d
C_11711420_30 |C AUTO IAUTO IAUTO

3e

Baseline Start Cycle .i; End Cycle: |Eii

~

Revertto Original Analysis Settings Apply Analysis Settings Cancel |

4. Adjust the flag settings:
Select the Flag Settings tab.

a
b. In the Use column, select the check box of each flag that you want to enable.

o

Adjust the value(s) for the enabled flags as needed.

d. If you want an enabled QC flag to automatically omit wells that test positive for
the condition it defines, select the Reject Well check box for the flag.

Note: The QC flags allow you to flag conditions and omit wells when certain
criteria are met (for example, when a well has missing data). For more information,
see the StepOne Software Help.

Notes
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= Analysis Settings for Genotyping Example

Call Settings I Ct Setlings I Flag Settings T Advanced Setlings ]

Flag Description Use Atribute Condition Value RejectV/ell
AMPNC Amplification in negative contral 3 < ~ |35 E
BADROX Bad passive reference signal Fluorescence < ~ 1500
BLFAIL Baseline algorithm failed 4]
CTFAIL CT algorithm failed O
EXPFAIL Exponential algorithm failed ]
OFFSCALE Fluorescence is offscale O
MNOAMP Mo amplification Amplification algorithm result < w101 E
NOISE Moise higher than others in plate Relative noise > w14 B
SPIKE Moise spikes Spike algorithm result > b ’17 O
NOSIGNAL Mo signal in well O
CLUSTER# Mumber of clusters outside expected range
PCFAIL Pasitive cantrol failed
SMCLUSTER Small number of samples in cluster Mumber of data points in the cluster < w12
THOLDFAIL Thresholding algarithm failed O
Revert to Original Analysis Settings Apply Analysis Settings EJ

5. Click Apply Analysis Settings.

6. Click Reanalyze to analyze the data using the new settings.

Analysis When you analyze your own experiment:

Guidelines » If your experiment consists of only two clusters, activate the 2-Cluster Calling
algorithm by selecting 2-Cluster Calling Enabled from the Edit Default SNP
Assay Settings dialog box.

» The C; Settings are available only for experiments that include amplification data.
Experiments that consist only of Pre- and Post-PCR reads do not use the threshold
cycle (Cy) system for analysis.

* You can call sample data:
— Automatically, using the Autocaller (see page 96)
— Manually, using the toolbar and scatterplot (see page 97)

For More For more information on the Analysis Settings, access the StepOne Software Help by
Information  clicking @) or pressing F1.

Notes
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Assign Calls Automatically
1. In the experiment, click Analysis Settings.
. Select the desired SNP Assay from the Select a SNP Assay table.
. Click Edit Default Settings.

2
3
4. If you have made manual calls, select Keep Manual Calls from Previous Analysis.
5. Select Autocaller Enabled to activate automatic analysis.

6

. If you expect the analyzed data to consist of only two clusters, select
2-Cluster Calling Enabled.

7. In the Quality Value field, enter a percentage value to apply as the quality interval
for auto-calling samples. (The greater the value, the more stringent the allele
calling.)

8. Click Save Changes to save your settings.
9. (Optional) Assign flags:
a. Select the Flag Settings tab.
b. Assign flags as desired.
Note: When you assign flags, you can flag conditions and omit wells when

certain criteria are met (for example, when a well has missing data). For more
information, see the StepOne™" Sofiware Help.

c. Click Apply Analysis Settings to close the Analysis Settings dialog box.

10. Click Reanalyze to analyze the data using the new settings.

Notes
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Assign Calls Manually

1.
2.

Notes

In the experiment, click Analysis Settings.
Select the desired SNP Assay from the Select a SNP Assay table.
Set the marker analysis settings:
a. Click Edit Default Settings.
b. Deselect the Autocaller Enabled.
c. Click Save Changes to save your settings.
(Optional) Assign flags:
a. Select the Flag Settings tab.

b. Assign flags as desired.

Note: When you assign flags, you can flag conditions and omit wells when
certain criteria are met (for example, when a well has missing data). For more
information, see the StepOne"" Software Help.

c. Click Apply Analysis Settings.
Click Reanalyze to analyze the data using the new settings.

In the navigation column, select [+ Allelic Discrimination Plot.

Select a marker from the SNP Assay menu. Crossmarks (X — Undetermined)
representing the selected marker are displayed in the Allelic Discrimination Plot.

To assign calls:
. Click [T (selection tool).

a
b. Click-drag a box around the desired data points in the plot.

(2}

. In the Apply Call menu, select the desired call.

o

. Repeat steps 8b and 8c to apply calls to the rest of the datapoints.

If you are assigning calls for multiple SNPs, select a different marker from the SNP
assay dropdown menu and repeat step 8.
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Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

For More  For more information publishing data, access the StepOne Software Help by clicking @)
Information or pressing F1.

Notes
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Appendix A

Alternate Experiment Workflows

This appendix covers:

B Advanced Setup Workflow . .. ... ... ... . . . 100
B QuickStart Workflow . ... ... . 101
B Template Workflow. . . ... .. . . 103
B Export/Import Workflow ......... .. ... . ... . . 105

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™" Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.
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Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne”™" software, you
can set up the experiment according to your own design.

1. Double-click g- (StepOne software) or select Start » All Programs » Applied
Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

2. Log in with a user name or as a Guest.

3. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

4. Complete the setup screens to set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

d. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

e. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® oo o

Notes
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Experiment Type Action

Comparative Ct . Prepare the template.

a

Genotyping b. Prepare the samplle dl|l:ItI0nS.
c. Prepare the reaction mix.

Presence/absence d. Prepare the reaction plate.

6. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
7. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve . Prepare the template.
. Prepare the sample dilutions.

a
b
c. Prepare the standard dilution series.
d
e

Standard curve

. Prepare the reaction mix.
. Prepare the reaction plate.

Comparative Cy a. Prepare the template.
Genotyping b. Prepare the samp.le dI|L'JtI0nS.
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.
Notes
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2. QuickStart the experiment:

a. Double-click g- (StepOne software) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
b. Log in with a user name or as a Guest.
c. From the Home screen, click [:Q QuickStart.

d. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

e. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

4. In the StepOne software, complete the plate setup:

Experiment Type Action

Genotyping a. Select and complete the Define SNP Assays and
Samples tab.

b. Select and complete the Assign SNP Assays and
Samples tab.

All other experiments a. Select and complete the Define Targets and
Samples tab.

b. Select and complete the Assign Targets and
Samples tab.

5. Analyze the data:
a. Open the experiment in the StepOne software.
b. From the Experiment Menu, click Analysis.

If the data are not analyzed, click Analyze.

o

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

You can use a template to create a new experiment. Templates are useful when you want
to create many experiments with the same setup information.

Createa 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Template Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.
2. Log in with a user name or as a Guest.

3. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 100).

4. Seclect File » Save As Template.
5. Enter a file name, select a location for the template, then click Save.

6. Click & Close.

Create an 1. From the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate and select the template you created in step d, then click Open. A new
experiment is created using the setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 100).

4. Click [d Save, enter a file name, then click Save to save the experiment.

Notes
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5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve | a. Prepare the template.

Standard curve b. Prepare the sample dI|L.ltIO-nS. .
c. Prepare the standard dilution series.

d. Prepare the reaction mix.

e

. Prepare the reaction plate.

Comparative Cy . Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p I u I
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

6. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
7. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments



Appendix A Alternate Experiment Workflows n
Export/Import Workflow

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Note: Setup data that are exported from experiments in StepOne Software v1.0 or v2.0
can be imported into experiments in StepOne Software v2.1. However, setup data that are
exported from experiments in StepOne Software v2.1 cannot be imported into
experiments in StepOne Software v1.0 or v2.0.

Export Setup 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Data Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.
2. Log in with a user name or as a Guest.

3. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 100).
4. Select File » Export.

5. Select the Export Properties tab (default), then:
. Select Setup.

a
b. Select One File from the dropdown menu.

o

Enter a name, then select a location for the export file.

d. Select [Z] (*.txt) from the File Type dropdown menu.

IMPORTANT! You cannot export *.xml files.

6. (Optional) Click the Customize Export tab, then select the appropriate options.
7. Click Start Export,

8. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with  plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

Notes
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1. Import the reaction plate setup data from an exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When finished, save the file
as a tab-delimited text file.

c. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.

e. Select File » Import.

f. Click Browse, locate and select the text file (*.txt), then click Select.

g. Click Start Import. The setup data from the exported text file is imported into

the open experiment.

Note: If your experiment already contains plate setup information, the
software asks if you want to replace the plate setup with the data from the text
file. Click Yes to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 100).

3. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve | a. Prepare the template.

Standard curve b. Prepare the sample dI|L.ltIO-nS. .
c. Prepare the standard dilution series.

d. Prepare the reaction mix.

e

. Prepare the reaction plate.

Comparative Cy . Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p ! u !
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

4. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

Notes
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Export/Import Workflow

5. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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108 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments



Bibliography

Afonina, 1., Zivarts, M., Kutyavin, 1., ef al., 1997. Efficient priming of PCR with short
oligonucleotides conjugated to a minor groove binder. Nucleic Acids Res. 25:2657-2660.

Kutyavin, I.V,, Lukhtanov, E.A., Gamper, H.B., and Meyer, R.B. 1997. Oligonucleotides
with conjugated dihydropyrroloindole tripeptides: base composition and backbone
effects on hybridization. Nucleic Acids Res. 25:3718-3723.

Kwok, S. and Higuchi, R. 1989. Avoiding false positives with PCR. Nature
339:237-238.

Lakowicz, J.R. 1983. Energy Transfer. In Principles of Fluorescence Spectroscopy, New
York: Plenum Press 303—339.

Lee, L. G., Connell, C. R., and Block, W. 1993. Allelic discrimination by nick-translation
PCR with fluorogenic probes. Nucleic Acids Res. 21:3761-3766.

Livak, K.J., Marmaro, J., and Todd, J.A. 1995. Towards fully automated genome-wide
polymorphism screening [letter]. Nat. Genet. 9:341-342.

Longo, M.C., Berninger, M.S., and Hartley, J.L. 1990. Use of uracil DNA glycosylase to
control carry-over contamination in polymerase chain reactions. Gene 93:125-128.

Mullis, K.B. and Faloona, F.A. 1987. Specific synthesis of DNA in vitro via a
polymerase-catalyzed chain reaction. Methods Enzymol. 155:335-350.

Saiki, R.K., Scharf, S., Faloona, E,, et al., 1985. Enzymatic amplification of B-globin
genomic sequences and restriction site analysis for diagnosis of sickle cell anemia.
Science 230:1350-1354.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 109
Genotyping Experiments



Bibliography

110 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Genotyping Experiments



Advanced Setup

AIF
allele

allelic discrimina-
tion plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

Glossary

In the StepOne™ software, a feature that allows you to set up your experiment according
to your experiment design. Advanced Setup provides you with maximum flexibility in the
design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed
in an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard
quantities and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

» Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

» Threshold cycle (Cy) vs. well
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Glossary

amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

baseline

112

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage
are displayed in an amplification plot, and the data are used to calculate results. For
genotyping or presence/absence experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting. See also cycling stage.

In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers
to amplify a target and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify
a target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
» AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for
the amplification plot. You can apply the automatic baseline setting to specific wells in
the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (CT).

In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.
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baseline-corrected
normalized reporter
(ARnN)

biological replicate

blocked IPC

calibrator
chemistry

colocated layout

Glossary

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs. Cycle amplification plot, ARn is calculated at each
cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments)
and the presence/absence plot (presence/absence experiments), ARn is calculated
as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

Reactions that contain identical components and volumes, but evaluate separate samples
of the same biological source (for example, samples from three different mice of the same
strain, or separate extractions of the same cell line or tissue sample).

When using biological replicate groups in a comparative C; study, the values displayed in
the Biological Replicates tab are calculated by combining the results of the separate
biological samples and treating this collection as a single population (that is, as one
sample). For AC; computations (normalizing by the endogenous control) in a singleplex
experiment, the separate biological samples are treated as unpaired data when computing
variability estimates of the single biological replicate. You can observe individual
contributions of the separate biological samples to the single biological replicate results
in the Technical Replicates tab.

Note: To view the Biological Replicates and Technical Replicates tabs, from the Study
Menu pane, select Analysis » Gene Expression.

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In the StepOne ™ software, the
task for the IPC target in wells that contain IPC blocking agent. See also negative control-
blocked IPC wells.

See reference sample.

See reagents.

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly
connected to a colocated computer by the yellow cable. In this layout, you can control the

instrument with the StepOne™ software on the colocated computer or with the instrument
touchscreen.
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Glossary

comparative C;
(AAC;) method

Cr

custom dye

cycle threshold

cycling stage

data collection

delta Rn (ARn)
derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
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Method for determining relative target quantity in samples. With the comparative C;
(AAC;) method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sample to normalized target
quantity in the reference sample.

See threshold cycle (CT).

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in
experiments on the StepOne™ and StepOnePlus'™ systems. When using custom dyes, the
custom dye should be added to the Dye Library and a custom dye calibration performed.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage. For cycling stages, you can enable AutoDelta settings. See also
amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the StepOne™
software, a data collection point is indicated by an icon in the thermal profile:

» Data collection on:

» Data collection off:
See baseline-corrected normalized reporter (DRn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn”) vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

A feature in the StepOne™ software that helps you set up your experiment by guiding you
through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of
the Reaction Setup screen. For this field, enter the sample concentration you want to use
to add to the reaction mix for all samples in the experiment. “10X for Reaction Mix”
indicates that the software assumes the sample or standard component of the reaction mix
is at a 10X concentration. For example, if the diluted sample concentration is 50.0 ng/uL
(10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.
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dissociation curve
EFF%

endogenous
control

endpoint read

experiment

experiment name

Glossary

See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative Cy (AACy)
experiments to normalize fluorescence signals for the target you are quantifying.
Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

When using multiple endogenous controls, the software treats all endogenous controls as
a single population, and calculates the experiment-appropriate mean to establish a single
value against which the target of interest is normalized. In comparative C experiments,
the mean calculated is the arithmetic mean of the C values. In relative standard curve
experiments, the C; values are converted to relative quantities prior to normalization; the
mean calculated is subsequently the geometric mean of the relative quantities.

Note: Arithmetic and geometric means are related and equivalent due to logarithmic
transformation of the data.

Variability estimates for multiple endogenous controls are computed separately. The final
variability estimate is a pooled combination of the individual variability estimates (similar
to computing pooled standard deviations).

See post-PCR read.

Refers to the entire process of performing a run using the StepOne™ or StepOnePlus™
systems, including setup, run, and analysis. The types of experiments you can perform
using the StepOne and StepOnePlus systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative C (AAC)

* Melt curve

* Genotyping

* Presence/absence

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark ("), vertical line (]), colon (%),

semicolon (), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex ("),
left parenthesis ( (), right parenthesis () ), or exclamation point (!).

IMPORTANT! If you run the instrument in standalone mode from the instrument
touchscreen, you cannot enter more than 32 characters in the Experiment Name field and
you cannot include spaces in the name.
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Glossary

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

manual Cy
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The type of experiment you are performing using the StepOne™ or StepOnePlus™ system:

» Standard curve
» Comparative C (AACy)
+ Relative standard curve
* Melt curve (not available in the Design Wizard)
* Genotyping
* Presence/absence
The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5" end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the
target is absent in the samples) and negative results caused by PCR inhibitors, incorrect
assay setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
StepOne™ software, the task for the IPC target in wells that contain the IPC and do not
contain [PC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.

TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control
specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage
melting
temperature (Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder
(NFQ-MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier
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Glossary

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of the target or can identify nonspecific PCR amplification.
In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs.
temperature or as derivative reporter (—Rn") vs. temperature. Also called dissociation
curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the StepOne™ software, the task for targets or SNP assays in wells that contain water
or buffer instead of sample. No amplification of the target should occur in negative control
wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked.
Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantitation. The minor groove binder (MGB)
increases the melting temperature (Tm) without increasing probe length. It also allows the
design of shorter probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.
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passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix
primer/probe mix
pure dye
quantitation

method

quantity
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A dye that produces fluorescence signal. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™
systems, the grid contains 6 rows and 8 columns. In StepOnePlus"™ systems, the grid
contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard
curve is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain
a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation
methods: standard curve, relative standard curve, and comparative C; (AAC).

In quantitation experiments, the amount of target in the samples. Absolute quantity can
refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-
difference between normalized quantity of target in the sample and normalized quantity
of target in the reference sample.
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quencher A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.
With SYBR® Green reagents, no quencher is used.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

QuickStart A feature in StepOne™ and StepOnePlus™ systems that allows you to run an experiment
without entering plate setup information. QuickStart requires a colocated layout with the
instrument powered on and an intact instrument-computer connection.

R? value Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C data points from the standard reactions. A value of 1.00 indicates a perfect
fit between the regression line and the data points.

ramp The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is
defined as a temperature increment. In the graphical view of the thermal profile, the ramp
is indicated by a diagonal line.

ramp speed Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

» For optimal results using the fast ramp speed, Applied Biosystems recommends
using fast reagents in your PCR reactions.

» For optimal results using the standard ramp speed, Applied Biosystems
recommends using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for presence/absence

experiments.
raw data plot A plot of raw fluorescence signal (not normalized) for each optical filter.
reaction mix A solution that contains all components to run the PCR reaction, except for the template

(sample, standard, or control).

reagents The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the StepOne'" and StepOnePlus™" systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

real-time PCR Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping
or presence/absence experiments.
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reference sample

refSNP ID

regression
coefficients

regression line

reject well

relative standard
curve method

Remote Monitor

replicate group

replicates

reporter

reverse primer
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In relative standard curve and comparative C (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called
an rs number.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard
curve method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A feature in the StepOne'™ software that allows you to monitor a StepOne™ or
StepOnePlus'™ instrument over the network. With the Remote Monitor, you can monitor
the instrument status, send an experiment to the instrument, monitor amplification plots
and temperature plots in real time, and download the results to your computer. You cannot
operate the StepOne or StepOnePlus instrument using the Remote Monitor.

A set of identical reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter
dye is SYBR® Green dye.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.
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reverse
transcriptase

Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

Glossary

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the StepOne™" and
StepOnePlus'™ systems. ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the StepOne"™ or
StepOnePlus'™ instrument run.

The template that you are testing.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is
added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 pL, the calculated volume of sample for 1 reaction is 2 uL.

In the StepOne™ software, a collection of samples. The Sample Library contains the
sample name and the sample color.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 UL, the calculated volume of sample or standard for 1 reaction is 2 L.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and
quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify
more than one target in one PCR reaction.

In the StepOne™ software, a numerical value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard curve
is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

series See standard dilution series.

slope Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

SNP Abbreviation for single nucleotide polymorphism. The SNP can consist of a base
difference or an insertion or deletion of one base.
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SNP assay

SNP Assay Library

spatial calibration

stage

standalone layout

standard

standard curve

standard curve
method

standard dilution
series
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Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the StepOne "™ software, a collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name, SNP assay color, and for each
allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in
the library may also contain the assay ID and comments about the SNP assay.

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the
positions of the wells in the sample block(s). Spatial calibration data are used so that the
software can associate increases in fluorescence during a run with specific wells in the
reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage (including pre-PCR read and post-PCR read), cycling stage (also called
amplification stage), and melt curve stage.

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to
a computer by the yellow cable. In this layout, you control the instrument only with the
instrument touchscreen, and you use a USB drive or network connection to transfer data
between the instrument and computer.

Sample that contains known standard quantities. Standard reactions are used in
quantitation experiments to generate standard curves. See also standard curve and
standard dilution series.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is
defined by the number of points in the dilution series, the number of standard
replicates, the starting quantity, and the serial factor. See also standard dilution
series.

Method for determining absolute target quantity in samples. With the standard curve
method, the StepOne"™ software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates the absolute quantity
of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the
first dilution point is used to prepare the second dilution point, and so on. In the StepOne "™
software, the volumes needed to prepare a standard dilution series are calculated by the
number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.
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standard quantity

starting quantity

step

study name

SYBR® Green
reagents

Glossary

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
StepOne'™ software, the units for standard quantity can be for mass, copy number,
viral load, or other units for measuring the quantity of target.

* In relative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the StepOne"" software, corresponds to the highest or
lowest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™
systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for
each VeriFlex block).

Entered during study setup, the name that is used to identify the study. Study names
cannot exceed 100 characters and cannot include any of the following characters: forward
slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark
(?7), quotation mark ("), vertical line (]), colon (:), semicolon (;), and sign (&), percent sign
(%), dollar sign ($), at sign (@), circumflex (*), left parenthesis ( (),

right parenthesis () ), or exclamation point (!).

PCR reaction components that consist of two primers designed to amplify the target and
SYBR® Green dye to detect double-stranded DNA.
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system dye

TaqMan® reagents

target

target color

Target Library

task
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Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or
StepOnePlus"™ system. Before you use system dyes in your experiments, make sure the
system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
« FAM™ dye
+ JOE™ dye
+ ROX™ dye
+ SYBR® Green dye
+ VIC® dye
System dyes on the StepOnePlus system:
« FAM"™ dye
« JOE™ dye
« NED™ dye
+ ROX™ dye
+ SYBR® Green dye
+ TAMRA™ dye
+ VIC® dye

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the StepOne™ software, a color assigned to a target to identify the target in the plate
layout and analysis plots.

In the StepOne™ software, a collection of targets to add to experiments. The targets in the
library contain the target name, reporter, quencher, and target color. The target in the
library may also contain comments about the target.

In the StepOne™ software, the type of reaction performed in the well for the target or SNP
assay. Available tasks:

* Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ IPC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)
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technical replicate

temperature plot

template

thermal profile

threshold

threshold cycle (Cy)

Tm
touchscreen

unknown

unknown-IPC wells

Glossary

Reactions that contain identical components and volumes, and that evaluate the same
sample.

In the StepOne ™ software, a display of temperatures for the sample, instrument cover, and
instrument block during the StepOne"™ or StepOnePlus"™ instrument run.

In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation
experiments), the type of nucleic acid to add to the PCR reaction. The recommended
template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C1) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

* Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
* Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic CT) or can be set manually (see manual CT).

2. In presence/absence experiments, the level of fluorescence above which the
StepOne™ software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification
plot.

See melting temperature (Tm).
Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrument.

In the StepOne™ software, the task for the target or SNP assay in wells that contain the
sample you are testing:

* In quantitation experiments, the task for the target in wells that contain a sample
with unknown target quantities.

* In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

* In presence/absence experiments, the task for the target in wells that contain a
sample in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control
(IPC).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 125

Genotyping Experiments



Glossary

VeriFlex™ The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex"™

Technology blocks, creating up to six different zones for the 96 sample wells. After you enable the
VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or
more of the VeriFlex blocks.

y-intercept In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.

zone One of up to six sample temperatures among the 96 wells formed by independently
thermally regulated VeriFlex'" blocks during the StepOnePlus™ instrument run. You can
set a different temperature for one or more of the VeriFlex blocks, or you can set the same
temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the
VeriFlex blocks.

zone boundary The edge of a zone for samples formed by the six independently thermally regulated
VeriFlex"™ blocks. In the StepOne™ software, the zone boundaries are displayed in the
plate layout as thick red lines.
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manual 97
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Applied Biosystems StepOne Real-Time PCR System.
See StepOne system.

assay information file (AIF) 23
assay mix 40

assumptions for using this guide vi
automatic allele calling 96
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BADROX flag 79, 81
baseline
about 88
adjusting 93
correct values 89
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biohazardous waste, handling xix
BLFAIL flag 80

C

CAUTION, description xii
chemical safety xvii
chemical waste safety xviii
CLUSTER flag 79
colocated layout
data transfer 66
monitoring 58
startup 54
consumables 32, 39, 40, 42
Also see materials required 4
supported 4
control
negative 25, 26, 75, 76, 85
positive 25, 26, 75
conventions used in this guide vi
create an experiment
example experiment 17
export 98
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documents xi

workflow 70 D
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contacting Xxi data
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prepare 38
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design 20, 22, 24, 26, 28, 31, 34, 36
preparation 39, 41, 43
run 53
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hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
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Help system, accessing x

installation category xx
instrument operation, safety xvi
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load reaction plate 42, 50

M

manual allele calling 97
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monitor run
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Temperature Plot screen 60
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MSDSs
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multiple plots, viewing 92
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apply 25, 26
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